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CHAPTER 1: INSURANCE RETURNS
The objective of this guide is to assist you in preparing your insurance return, whether it is a consolidation or is
filed as a single return.

TOPICS COVERED
This manual includes:

l Overview for Insurance Returns

l Using the Tax Accounting System

l Choosing the NAIC annual statement as your data method

l Preparing Insurance Returns

l Working with Your 1120-L Tax Return

l Working in Your 1120-PC Return

l Working in the Tax Application

l Net Operating Loss

l Consolidating Your Insurance Return

l Working in your Consolidation

l Printing the Return

l Mixed Group State Consolidation

l International

HOW DO I GET STARTED?
The first thing you should decide is how you want to enter your information into ONESOURCE Income Tax.

You can either use the Tax Accounting System and import balances and adjustment amounts, which also uses
the automatic Schedule M-3 functionality, or you can import data from the NAIC Annual Statement into
Organizer.

ONESOURCE
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2 Chapter 1: Insurance Returns

How do I get started?

Charts for Insurance Returns
In addition to assigning a federal chart of accounts and adjustment charts, you can also assign State TI
Workpapers, Forms Mapping charts to insurance binders.

You can map accounts of a federal chart of accounts to the lines of the NAIC Annual Statement on the NAIC
Annual Statement Line mapping charts. These mapping charts are year specific for a particular federal chart of
accounts, for 1120L -Life and Separate Accounts, for 1120PC - Property/Casualty, Health, and Title NAIC
types. The mapping charts are located in the Charts folder, under the Federal folder, and named NAIC
Annual Statement, Line Mapping. When you assign the mapped chart of accounts to a binder, the NAIC
Annual Statement Reconciliation views for 1120L and 1120PC automatically populate for the Balance Sheet
and Statement of Income.

NAICANNUAL STATEMENT LINEMAPPING CHART

Figure 1:1

ONESOURCE
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Chapter 1: Insurance Returns 3

How do I get started?

STATETI WORKPAPERFORMSMAPPING CHART

Figure 1:2

If you use the Tax Accounting System for insurance returns, the process starts with setting up charts, then
importing or entering data in the Tax Accounting System, reviewing data, and then computing the binder to
transfer the data into the tax application Organizer.

Follow our best insurance practices and choose the correct entity type, data source, and structure to set up
your insurance return. Then your return calculates and prints correctly, and allows for a successful e-filing to
the IRS or states.

Consolidations
Complex federal regulations governing consolidations for mixed group consolidations are a difficult and
complicated process. After correctly identifying your consolidation structure, several concerns that are unique
to mixed group consolidations, such as loss reserve discounting, salvage and subrogation, failed-life returns,
and statutory-to-tax adjustments require specialized expertise and intricate calculations. Taking these into
consideration, this manual guides you through the tax return preparation process.

ONESOURCE
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CHAPTER 2: SETTING UP ONESOURCE
INCOME TAX FOR INSURANCE RETURNS
Setting up the system for insurance returns begins like any other return. You must first start in the Binder list,
complete the necessary set up of charts, and assign the charts to binders. Later, your work continues in the Tax
Accounting System importing preliminary balances, making adjustments, and viewing the working trial balance
and reports. Finally, after computing the binder, you finalize the return in Organizer.

The NAIC Annual Statement Reconciliation screen allows you to review account detail in NAIC line format.
There are also State Taxable Income (TI) Workpapers for insurance binders.

You can also use the Tax Accounting System Schedule M-3 functionality for insurance returns by creating
Schedule M-3 Line Coding for 1120L and 1120PC, mapping your federal accounts to a specific Schedule M-3
chart, which then automatically populates the form.

If you use the ONESOURCETax Provision software, the tax adjustments and balances data entry
functions in TASmakes it more compatible than using the NAIC transfer.

HOW TO SET UP ONESOURCE INCOME TAX FOR
INSURANCE RETURNS

l Create a Tax Combination Chart.

l Import TCCs into the new Chart of TCCs.

l Verify TRC and TCC are applicable to 1120L and 1120PC returns.

l Create a Federal Chart of Accounts.

l Create Charts of Adjustments (book, reclassification, and tax) using those Charts of Accounts.

l Assign charts to binders.

l Import balances and adjustments either within an individual binder or using batch import.

l Create a NAIC Line Mapping Chart.

l Rollover or create binders.

ONESOURCE
1120 INSURANCE GUIDE



5 Chapter 2: Setting Up ONESOURCE Income Tax for Insurance Returns

Chart and Adjustment Information

l Create State Taxable Income Forms Mapping Charts to map state modifications to state income tax forms
and schedules. Four states (New York, Mississippi, Michigan, Oregon) have insurance specific forms to
file for insurance companies. These states will use an insurance type of Forms Mapping Chart.

CHART AND ADJUSTMENT INFORMATION
Refer to the following chapters in theONESOURCE Income TaxUser Guide for more information on how to
set up charts and enter balances and adjustment data.

APPLICATION
AREA

TASKS

Federal Charts Creating and importing into the following types of charts:

Chart of TaxCombination Codeswith TRCs applicable to 1120L and 1120PC returns

Chart of Federal Accounts

Chart of Federal Adjustments

ScheduleM3 Line Coding andMapping

NAIC LineMapping

State Taxable IncomeWorkpaper FormsMapping Chart for Insurance (New York,
Mississippi, Michigan, Oregon, insurance specific)

Tax Accounting
System (TAS)

Create binders to hold data for an entity for a year

Enter balance and adjustment data

View theWTB and reports

View NAIC Annual Statement Reconciliation

InsuranceWorkpapers

(Data is grouped and used for the tax return.)

State Processing State Taxable IncomeWorkpaper System

ONESOURCE
1120 INSURANCE GUIDE



Chapter 2: Setting Up ONESOURCE Income Tax for Insurance Returns 6

NAIC Annual Statement Line Mapping Chart

ONESOURCE Income Tax Insurance Functionality
The Tax Accounting System has an Insurance NAIC Annual Statement Reconciliation screen for 1120L
and 1120PC. The screen displays accounts grouped by the NAIC Annual Statement Lines for the Balance
Sheet and Statement of Income. The workpapers are accessible from the TAS navigation tree asNAIC
Annual Statement Reconciliation. The screen has two tabs,Balance Sheet and Statement of Income
(1120PC) or Summary of Operations (1120L) to display the views. The views are expandable to show
account and amount detail and are “read only.” You cannot enter data.

NAIC ANNUAL STATEMENT LINE MAPPING CHART
You can use the mapping chart to assign accounts for a federal chart of accounts to the lines of the NAIC
Annual Statement. The mapping charts are year specific for a particular federal chart of accounts for either
1120L or 1120PC. The 1120L return type displays Life and Separate Accounts NAIC types; the 1120PC return
type displays Property/Casualty, Health, and Title NAIC types.

CREATING AN INSURANCELINEMAPPING CHART

1. In the HomeWindow, clickCharts > Federal >NAIC Annual Statement. This opens the NAIC Annual
Statement Line Mapping screen.

Figure 2:1

2. Select the Year from the drop-down list.

ONESOURCE
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7 Chapter 2: Setting Up ONESOURCE Income Tax for Insurance Returns

NAIC Annual Statement Line Mapping Chart

3. Select the appropriate Tax Return/NAIC Type from the drop-down list:

l 1120L - Life (default)

l 1120L - Separate Accounts

l 1120PC - Property/Casualty

l 1120PC - Health

l 1120PC - Title

4. Select the applicable Chart of Accounts from the drop-down list. The unmapped federal accounts display
in the left pane and the NAIC Annual Statement lines and mapped accounts display in the right pane.

Figure 2:2

5. In the Accounts drop-down list, you can choose to viewAll Accounts,Balance Sheet, or Income
Statement accounts. Only accounts which are valid for the tax return type will display.

6. In the Search field , enter an account number or description and the system will search
and highlight all the instances of the search item in the right (Assigned) pane. If the search item is not
found, you will get a message that saysNomatches found.

7. Select the Federal Account you wish to map the account to the NAIC Annual Statement Lines pane.

8. SelectAdd to map an account, or selectRemove to remove the mapping.

9. Select Export to export a file to use as a template which you can then modify and import.

ONESOURCE
1120 INSURANCE GUIDE



Chapter 2: Setting Up ONESOURCE Income Tax for Insurance Returns 8

Tax Accounting System with Insurance

10. Select Import to import a data file. The two fields in the template are:

l NAICMap Code

l Account Number

TAX ACCOUNTING SYSTEM WITH INSURANCE
In 1120L and 1120PC binders, the Tax Accounting System (TAS) navigation tree has additional screens, the
NAIC Annual Statement Reconciliation and Insurance Workpapers.

NAIC Annual Statement Reconciliation
The views on this screen are sorted by the NAIC Annual Statement lines and display accounts according to the
mapping chart you created in the Charts menu. Amounts display normal balances to be consistent with the
NAIC Annual presentation.

BALANCESHEET

Figure 2:3

ONESOURCE
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9 Chapter 2: Setting Up ONESOURCE Income Tax for Insurance Returns

Tax Accounting System with Insurance

SUMMARYOFOPERATIONS

Figure 2:4

On the workpaper, you can select the NAIC Type from the drop-down list.

Figure 2:5

Select the gear icon to change what you see on the NAIC Annual Statement Reconciliation.

ONESOURCE
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Chapter 2: Setting Up ONESOURCE Income Tax for Insurance Returns 10

Tax Accounting System Menu Tree with Insurance

NAIC Annual Statement Line Mapping Chart

Figure 2:6

You can rollover the chart either individually or by using the Batch Chart Rollover feature.

TAX ACCOUNTING SYSTEM MENU TREE WITH
INSURANCE
In 1120L and 1120PC binders, you can see the screens on the Tax Accounting System navigation tree on the
NAIC Annual Statement Reconciliation and Insurance Workpapers screens.

The 1120PC Tax Accounting System 1120PC navigation menu is similar to the 1120L, with an additional item
for Schedule M-2, and it does not include Insurance Workpapers.

NAIC Annual Statement Reconciliation Screen
The views on this screen are sorted by the NAIC Annual Statement lines and display accounts according to the
mapping chart you created in the HomeWindow. Amounts display normal balances to be consistent with the
NAIC Annual presentation. On the workpaper, you can select the NAIC Type from the drop-down list.

You can rollover the chart either individually or by using the batch chart rollover feature.

ONESOURCE
1120 INSURANCE GUIDE



11 Chapter 2: Setting Up ONESOURCE Income Tax for Insurance Returns

Tax Accounting System Menu Tree with Insurance

OPENING THENAICANNUAL STATEMENTRECONCILIATION

1. Open a binder.

2. On the TAS navigation tree, selectNAIC Annual Statement Reconciliation.

Figure 2:7

3. Select the NAIC Type from the drop-down list.

4. Click Export to save this information to a spreadsheet file.

5. Click Print to print a copy. The print default settings are landscape and letter sized paper.

Action Items
Action Items in TAS in addition to items generated for other tax return types also generate items for the
following:

l NAIC Annual Statement Map identifies and lists accounts in the binder that have data but have not
been mapped in the NAIC Annual Statement Map chart.

l AData Input Review item informs you whenever total assets do not equal total liabilities, surplus,
and other funds on the NAIC Annual Statement Reconciliation. The comparison is for the Adjusted Book
Balances.

These action item messages are created whenever one account has been mapped for the tax return type,
NAIC type, and the federal chart of accounts is assigned to the binder.

ONESOURCE
1120 INSURANCE GUIDE



Chapter 2: Setting Up ONESOURCE Income Tax for Insurance Returns 12

Working Trial Balance (WTB) and Insurance

WORKING TRIAL BALANCE (WTB) AND INSURANCE
The Working Trial Balance screen for 1120L looks like this:

Figure 2:8

The Working Trial Balance screen for 1120PC looks like this:

Figure 2:9

In addition, Columnar WTB is available for insurance binders that have a level of consolidation of Subgroup.

ONESOURCE
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13 Chapter 2: Setting Up ONESOURCE Income Tax for Insurance Returns

State Taxable Income Workpapers

TRCCROSS-REFERENCEFORMRESOURCES

Go to theWTB screen and expand the view to level 1 to see which TRCs are used for each line of the tax return

Refer to:

l 1120LONESOURCE Income Tax TRC andCross-ReferenceGuide

l 1120PC ONESOURCE Income Tax TRC andCross-ReferencesGuide

Refer to the Default Chart of TCCs and select the tax return type from the drop-down list to see a list of the valid
TRCs for insurance.

STATE TAXABLE INCOME WORKPAPERS
State Taxable IncomeWorkpapers are available for insurance binders. New York, Mississippi, Michigan, and
Oregon have insurance specific forms to file for insurance companies. For these states, a separate State TI
Forms Mapping Chart is available for state modifications to the insurance forms and schedules. For other
states, you can assign the income type of mapping chart to insurance binders.

To use the State TI Insurance Mapping Chart, set up the jurisdictions as you normally would in the system.
Refer to the State Processing chapter in theONESOURCE Income TaxRS User Guide for more information.

1120PC Schedule E and F Options
There are two options available to populate 1120-PC Schedule E PremiumsEarned and Schedule F Losses
Incurred. You can choose either the Defaultmethod or the Alternatemethod.

DEFAULTANDALTERNATEMETHODFORTHE1120-PCSCHEDULESEAND
F

Default: The default method populates the lines in the 1120-PC Schedules E and F using income statement
TRCs. See theONESOURCE Income Tax TRC Lists and Cross-Reference FormsGuide on Customer Center
for a list of specific TRCs used for each line.

Alternate: The Alternate method uses the Adjusted Tax Balance amounts of liability accounts to populate
Schedules E and F. See theONESOURCE Income Tax TRC Lists and Cross-Reference FormsGuide on
Customer Center for specific TRCs used for each line.

ONESOURCE
1120 INSURANCE GUIDE



Chapter 2: Setting Up ONESOURCE Income Tax for Insurance Returns 14

State Taxable Income Workpapers

If you use the Alternate method, check the box to Check to carry in reserves from Balance Sheet to
Schedule E and F.

NAICTRANSFERFORCERTAINSCHEDULES

You can still transfer certain schedules to supplement imported data even when you use the Tax Accounting
System (TAS) to import it. The NAIC Annual Statement Transfer screen limits TAS users access to all
schedules but does allow access to certain schedules.

If you use TAS, you can import the following schedules:

1120-PC Property & Casualty Annual Statement Schedules

l Loss Reserve Discounting (LRD)

l LRD and Schedule T

l Schedule T

1120-L Life Annual Statement Schedules

l Deferred Acquisition Cost (DAC)

l DAC and Schedule T

l Schedule T

FAILEDLIFE INSURANCEDATAENTRY

We currently do not support transferring data from TAS to Organizer for failed life insurance companies that are
converted to 1120PCs for tax return purposes. Use the NAICmethod for those returns. Thus, for failed life
insurance companies, continue to check the boxes in Organizer on the Failed Life Conversion screen to (1)
activate the 1120-PC and to (2) deactivate the 1120L form.

TASCONSOLIDATIONS

TAS consolidations are available for only like-kind groups: 1120L sub-groups, 1120PC sub-groups, or 1120
sub-groups. Consolidations of nonlife and life / non-life groups are completed in the Organizer.

ONESOURCE
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CHAPTER 3: SELECTING THE DATA
SOURCE
There are two data sources for your Insurance returns:

NAIC ANNUAL STATEMENT
The bulk of the information needed to prepare insurance income tax returns (1120-L and 1120-PC) is found in
the National Association of Insurance Commissioners (NAIC) Annual Statement. NAIC determines the
standards for financial reporting for insurance companies. The Annual Statement information is stored in
designated NAIC files that are then filed with the regulatory state. Each file is identified by a standard name that
indicates the return type and the filing period to which it pertains, and each insurance company’s unique NAIC
number.

An import of the NAIC Annual Statement file populates the Annual Statement of the Organizer pages, which
then flows to the appropriate Tax Forms in the tax application. Not all data is transferred from the Annual
Statement, only the data that is needed for tax compliance calculations and print is imported into the Organizer.

To transfer the NAIC Annual Statement for the 1120-L or 1120-PC tax returns, choose the correct data source
type. The tax application allows the transfer of these types of Annual Statements:

l Life (1120-L)

l Separate Accounts (1120-L)

l Property and Casualty (1120-PC)

l Health (1120-PC)

l Title (1120-PC)

NAICANNUAL STATEMENTTRANSFER

You can import NAIC data directly from their Annual Statement file to the appropriate place in the tax
application. However, only certain pages, and not the entire statement, are transferred into the Annual
Statement Organizer because the rest is not needed. If additional data is desired, the client can use the
Electronic Organizer to add this information.

ONESOURCE
1120 INSURANCE GUIDE



16 Chapter 3: Selecting the Data Source

NAIC Annual Statement

To transfer data:

1. On the Organizer tab, selectNAIC Annual Statement Transfer.

2. Verify the path and filename, transfer format, and filing year are correct. You must be able to fit the entire
path, including the TXT extension inside the field provided.

3. SelectBrowse.

4. Browse to the import file, and selectOpen.

5. Select the Transfer Format drop-down box. This lists the available transfers.

6. Select the Year drop-down box. Prior years are available for life and separate account annual statements
and LRD transfers.

7. After verifying the information, select Transfer, and then selectOK.

Data transferred into the Annual Statement pages from an NAIC statement flows automatically to the provided
yellow tax detail workpapers. Workpapers are used to show the calculations and how a particular number in a
return was derived. You can print the workpapers with the federal return, or print them separately along with the
federal schedules that support the return. They are available for the preparer’s use and are intended to simplify
the review process, as well as provide an audit trail.

ONESOURCE
1120 INSURANCE GUIDE



Chapter 3: Selecting the Data Source 17

NAIC Annual Statement

ANNUAL STATEMENTTRANSFERFORSHORTYEARRETURNS

Income statement items for the short year tax return period are automatically prorated based on the number of
days in the short year when compared to the total number of days in the tax year. In the example below, the
income statement amounts would be calculated as half of the full year transferred amounts. Balance sheet
items are not prorated.

Figure 3:1

The tax software supports Annual Statement transfers only. The import of quarterly statement files
is not supported.

NAICMAPPING TO THETAXRETURN

Worksheets are available to identify mapping of the NAIC Annual statement to 1120-L and 1120-PC, and to
assist in the reconciliation and preparation of the tax return. There are two separate files available:

l Property and Casualtymapping (https://www.riahelp.com/html/2021/reports/ins_mapping/1120PC_
Property_and_Casualty_Mapping.pdf)

l Life Annual Statement mapping. (https://www.riahelp.com/html/2021/reports/ins_mapping/1120L_Life_
Annual_Statement_Mapping.pdf)

The files are updated annually to reflect the latest tax law changes.

ONESOURCE
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18 Chapter 3: Selecting the Data Source

NAIC Annual Statement

STATUTORY-TO-TAXADJUSTMENTS

Important differences between accrual and statutory accounting methods require special statutory-to-tax
adjustments that are made when preparing the federal and state tax returns. Adjustments are made
automatically when transferring the Annual Statement.

Statutory-to-tax adjustments are made to the statutory data of the transferred Annual Statement balances to
arrive at net taxable income for the federal return. These adjustments follow the same general philosophy as
those made to book income for a domestic corporation. The most common example is the adjustment made
when depreciation for financial reporting purposes differs from depreciation for tax purposes.

Other adjustments that must take place for the taxable income computation include:

l Tax-exempt interest

l Change in due and accrued dividends

l Change in deferred and uncollected premiums

l Change in deposit type contracts

l Premium amortization

l Capital gains

l Elimination of change in loading

l Elimination of home office rent

l Elimination of NAIC amortization

l Elimination of NAIC depreciation

l Elimination of market discount accrual

l Difference in collected and earned real estate

l Interest on encumbrances

l Increase in loading on deferred & uncollected premiums

l Investment expenses.

ONESOURCE
1120 INSURANCE GUIDE



Chapter 3: Selecting the Data Source 19

Electronic Organizer

ELECTRONIC ORGANIZER
If the insurance company is not required to file an Annual Statement, data can be entered directly into the 1120-
L or 1120-PC Electronic Organizer. The data source method selected should be Electronic Organizer, not
Annual Statement.

Data that is directly entered in the Annual Statement Organizer pages is not supported. All data
entry should be made in the 1120-L or 1120-PC Electronic Organizer.

SCHEDULEM-3

There are two ways to complete the data entry for Schedule M-3 in the Electronic Organizer. The first method,
DIF import files, is preferred because it saves you the most time.

DIF Import Files

l DIF import files are used to import data for all three parts of Schedule M-3.

l Part I of Schedule M-3 is used only for single company or top consolidated returns.

l DIF import files are available for 1120-L, 1120-PC, and 1120 separate returns, including Part I for top
consolidations.

l Use the Schedule M-3 DIF/KAT files located at this link
(https://www.riahelp.com/html/2021/guides/1120/2021_DIF_1120_Sch_M-3.zip) to import the data.

ONESOURCE
1120 INSURANCE GUIDE
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20 Chapter 3: Selecting the Data Source

Electronic Organizer

Data Entry

Entering Schedule M-3 data directly into the Electronic Organizer. Data can be directly entered in the M-3
Organizer fields. The navigation is:

l 1120L:Organizer > Life Electronic Organizer Page 7 > Schedule M-3

l 1120PC: Organizer > PC Electronic Organizer Page 8 > Schedule M-3.

Figure 3:2

STATUTORY-TO-TAXADJUSTMENTS

Because tax adjustment balances are entered directly into the Organizer, there are no statutory-to-tax
adjustments. Statutory tax adjustments are used for Annual Statement users only.

ADJUSTMENTSANDRECLASSES

Adjustments, which are made either automatically or entered directly in the Organizer while preparing the
return, are one-sided only. However, Reclasses are two-sided entities with both a debit and credit amount
entered. An example of a reclass adjustment occurs when an amount is included inOther Incomewhen it
should have been included in Interest Expense.

You can reconcile a balanced return back to the statutory calculations through a summary of reclasses and tax
adjustments. This summary is an important part of the supporting documentation of the insurance return.

ONESOURCE
1120 INSURANCE GUIDE



Chapter 3: Selecting the Data Source 21

Electronic Organizer

Navigation: Tax Forms > Federal > 1120-PC Corporate Income Tax Return > 1120-PC Pg 1-8 > 1120-
PC, Page 2 tab

Select the link on line 13 to view the yellow detail.

Figure 3:3

ONESOURCE
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22 Chapter 3: Selecting the Data Source

Electronic Organizer

Select the link (blue turn-down arrow) in theOther Income field on the tax return.

Figure 3:4

ONESOURCE
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Chapter 3: Selecting the Data Source 23

Electronic Organizer

Scroll down toOther Income Reclassed Items orOther Income Tax Adjustments, which are shown on
the yellow detail image. Select theOther Income tab to view a screen where you can enter adjustments.

Figure 3:5

ONESOURCE
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24 Chapter 3: Selecting the Data Source

Electronic Organizer

RECLASSES INBALANCE

To keep a return in balance, reclass items must be balanced entries. You can verify that the return is balanced
by navigating to the Total Reclasses per reconciliation field, which is the second field shown on the screen
below and is outlined with a box.

Navigation: Tax Forms > Federal > 1120-PC Corporate Income Tax Return > Tax Summary > Tax to
A/S Reconciliation tab

Figure 3:6

ONESOURCE
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Chapter 3: Selecting the Data Source 25

Electronic Organizer

You can select the field and use the down arrow link to open the Summary of Statutory Reclassed Items. If
the return is in balance, a message stating this appears at the bottom of the screen.

Figure 3:7

ONESOURCE
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CHAPTER 4: CREATING YOUR RETURN IN
ONESOURCE INCOME TAX
Create and set up your insurance return by choosing the proper return type, entity type, and data source.
When creating an Insurance Consolidation, the compute, print, and e-file components do not work correctly if
these selection are not accurate.

There are two ways to create your return:

l Rollover a previous year return, so the prior year ending balances are shown in the beginning balance
columns for current year.

l Create an entirely new return, and either import or enter the beginning and ending balances.

Step 1: Rollover Return
Rollover the appropriate binder(s).

For rollover information, please refer to theONESOURCE Income TaxUser Guide.

Step 2: Choose Return/Entity Type
Review the information found on the Return/Entity Type tab after creating or rolling over a return.

1. Binders inherit their return type from the entity under which they are created. To edit an entity’s properties,
select the entity on the Entities screen.

2. Select the Properties icon in the Actions column.

3. On the Entity Properties screen, verify the Return Type is correct for an insurance return or
consolidation.

Step 3: Enter Federal Tax ID Number
The federal tax ID number (FEIN) is mandatory for all 1120L and 1120PC entities, except for eliminations,
subconsolidations, top consolidations, and divisions.

ONESOURCE
1120 INSURANCE GUIDE



27 Chapter 4: Creating Your Return in ONESOURCE Income Tax

Tax Accounting System Menu Tree for Insurance

Review the tax ID by going toOrganizer > General Information > Basic Return Information > Entity
Information of the created return. The FEIN for a binder is inherited from the entity.

REQUIREMENTS

l Parent, Subsidiary, or Single Entity: The tax ID isRequired for the individual company.

l Subgroup Subconsolidation: Tax ID isNot Required.

l Top Consolidation (topcon): The Parent tax ID transfers to this level. You should not have to enter it.

l Eliminations: Tax ID isNot Required.

l Division: Tax ID isNot Required.

l Divisional Consolidation: Tax ID isRequired.

l EINs Applied for: This check box is available on theGeneral Information screen.

Step 4: Select the Data Source
Ordinarily, the Source of Data for Tax Return will be the Electronic Organizer, whenever charts are
assigned to an entity's binder. Otherwise, select the NAIC Annual Statement type.

TAX ACCOUNTING SYSTEM MENU TREE FOR
INSURANCE
The Tax Accounting System has two items in the navigation tree that are unique to insurance returns, the NAIC
Annual Statement Reconciliation and Insurance Workpapers (1120L).
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NAIC Annual Statement Reconciliation Screen

Figure 4:1

NAIC ANNUAL STATEMENT RECONCILIATION SCREEN
The columns on this screen are similar to theWorking Trial Balance screen.

Select the NAIC type from the drop-down list. The rows display the NAIC Annual Statement lines for the
selected NAIC type and the accounts and amounts according to the mapping chart. Amounts display normal
balances.

Figure 4:2

ONESOURCE
1120 INSURANCE GUIDE



29 Chapter 4: Creating Your Return in ONESOURCE Income Tax

NAIC Annual Statement Reconciliation Screen

Opening the NAIC Annual Statement Reconciliation
1. Open a binder.

2. On the TAS navigation tree, selectNAIC Annual Statement Reconciliation.

3. Select the NAIC Type from the drop-down list.

4. Click Export to save this information to a spreadsheet file.

5. Click Print to print a copy. The print default settings are landscape and letter sized paper.

Opening Insurance Workpapers
1. From the TAS navigation tree, select Insurance Workpapers.

2. Verify that the appropriate schedule is displayed.

3. Verify that the correct amounts for the insurance schedules are displayed.

4. In theMy Binders list, select the binder, then selectCopy Binder .

5. Select the options to copy that apply.

6. ClickOK.

7. In TAS, clickCompute.

8. SelectUpdate Organizer to transfer the insurance information to the Organizer.

Step 5: Set Up Division
Refer to theONESOURCE Income TaxUser Guide for more information about divisions.

Step 6: Determine Net Operating Loss
Refer to theONESOURCE Income TaxUser Guide for more information about net operating loss.
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CHAPTER 5: 1120L RETURNS
The IRS Form 1120-L, the US Life Insurance Company Income Tax Return, is used to report the income, gains,
losses, deductions, and credits, and to figure the income tax liability of life insurance companies. Every
domestic life insurance company, as well as every foreign corporation that would qualify as a life insurance
company if it were a US corporation, must file a Form 1120-L. Insurance companies other than life insurance
companies should file Form 1120-PC, the USProperty and Casualty Insurance Company Income Tax Return.

Insurance Company A corporation is an insurance company if more than half of its business during the tax
year is from the issuance of insurance or annuity contracts, or the reinsuring of risks underwritten by insurance
companies.

Life Insurance Company A life insurance company is an insurance company in the business of issuing life
insurance and annuity contracts, either separately or combined with health and accident insurance, or
noncancellable contracts of health and accident insurance that meet the reserves test in Section 816(a).
Guaranteed renewable life, health, and accident insurance that a corporation cannot cancel but reserves the
right to adjust premium rates by classes, according to experience under the kind of policy involved, is treated as
noncancellable.

LIFE INSURANCE RESERVES TEST
The reserves test requires life insurance reserves, as defined in Section 816(b), plus unearned premiums and
unpaid losses (whether or not ascertained) on noncancellable life, health, or accident policies not included in
life insurance reserves must make up more than 50%of total reserves as defined in Section 816(c). When
determining whether the reserves test has been met:

l Life insurance reserves and total reserves must each be reduced by an amount equal to the mean of the
aggregates at the beginning and end of the tax year, of the policy loans outstanding with respect to
contracts for which life insurance reserves are maintained.

l Amounts set aside and held at interest to satisfy obligations under contracts that do not contain permanent
guarantees with respect to life, accident, or health contingencies must not be included in either life
insurance reserves (Section 816(c)(1)) or other reserves required by law (Section 816(c)(3)).

l Deficiency reserves must not be included in either life insurance reserves or total reserves.

FAILED LIFE
See Failed Life (page 31) for more information.
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1120L Unique Items

1120L UNIQUE ITEMS
See Unique Items (page 32) for more information.

FAILED LIFE
A life insurance company is in the business of issuing life, annuity, and certain health insurance policies. A failed
life return is a Life Insurance company with a Life Insurance Annual Statement that does not meet the reserves
qualifications to file on an 1120-L tax return per IRS rules. An insurance company that does not qualify as a life
insurance company under the IRS rules files an 1120-PC tax return for the IRS’s filing purpose.

Using The Life NAIC Import
If you have a failed life tax return and you want to import the Life Annual Statement, the return must be created
as an 1120-L tax return in our tax application. After creation, you must import the Life Annual Statement and
check the Failed Life check box to convert the life insurance data from the 1120-L. We then automatically
populate the 1120-PC tax return. The 1120-PC tax return is the tax return visible on the Tax Forms page for
filing to the IRS. The 1120-L tax return is disabled.

Which type of subgroup Subconsolidation does the failed life belong to?

Without regard to the way you created the failed life or the method you used to populate the failed life return
data, the failed life tax return (1120-PC) is included in the 1120-PC subgroup for consolidation purposes. It can
be confusing since you might have to create the failed life return by creating a life return to use the Life Annual
Statement transfer, and then convert it to an 1120-PC return. The PC subgroup Subconsolidation consists of all
the 1120-PC returns to be filed to the IRS, whether they are created as 1120-PC, or converted to 1120-PC
because they are failed life returns.

Failed Life Conversion

Use the following steps to help you create your failed life return, if you are using the Life Annual Statement
transfer method.

1. Create an 1120-L return.

2. Do not enter any numbers in the 1120-L Organizer at this point. Wait until after conversion to the 1120-PC
to enter amounts in the Organizer.

3. Transfer the Life Annual Statement.
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Unique Items

4. Turn offAuto Compute in the 1120-L return.

5. In the Failed Life Return section, select both check boxes at the bottom of the screen. One box
deactivates the 1120-L; the other activates the 1120-PC area and the tax form. The failed life check boxes
are at on the screen shown in theOrganizer > General Information > Basic Return Information >
Entity Information.

Figure 5:1

6. The 1120-PC tax forms now appear in Tax Forms and the 1120-PCOrganizer. All Organizer entries must
now be made in the 1120-PCOrganizer, not in the 1120-L Organizer.

7. If this failed life return is to be consolidated with other returns, it must be included in an 1120-PC subgroup
Subconsolidation.

UNIQUE ITEMS

DAC – Deferred Acquisition Costs
Deferred Acquisition Costs (DAC) are amortized under Section 848 and entered mostly on 1120-L returns,
and occasionally on 1120-PC returns. The Deferred Acquisition Costs are located on the 1120-L, Page 4,
Schedule G (go to Tax Forms > Federal > 1120-L - US Corporation Inc Tax Return > 1120-L - US
Corporation Inc Tax Return > Page 3). These expenses are incurred when gathering new premiums that
then must be amortized on the 1120-L tax return.
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Annual Statement Users

The tax application automatically transfers in Premiums,Advance Premiums, and Deferred and
Uncollected Premiums from the Annual Statement.

Adjustments to DAC

To make adjustments in each premium type, choose a tab in the Direct Business Premiums Worksheet
such asAnnuity,Group Life, orOther Life. In theOther Adjustments to Premiums column in the last
row, you can enter adjustment in the field titledOther Adjustments.

The Totals tab sums all three tabs for review purposes.

Navigation:Organizer > Deferred Acquisition Costs > Direct Business > Direct Business Premiums
Worksheet > Totals tab

Figure 5:2
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Navigation:Organizer > Deferred Acquisition Costs > Direct Business > Direct Business Premiums
Worksheet > Annuity tab

Figure 5:3

Schedule T
The Annual Statement Schedule T provides state premium numbers for the state tax returns. Schedule T in
the Organizer is automatically populated when you import the Annual Statement for Life and PC Annual
Statement returns. The premium total numbers also populate the Allocation and Apportionment area
automatically for the states once the state area is activated.

ONESOURCE
1120 INSURANCE GUIDE



35 Chapter 5: 1120L Returns
Unique Items

Navigation:Organizer > Life Annual Statement > Page 48 - Schedule T

Figure 5:4

If you want to suppress the Schedule T premium amounts from populating the States Allocation
and Apportionment area, use the check box in the Organizer at the top of the Schedule T. The
figure above shows the check box to suppress Schedule T.

Organizer users can only enter the data directly into the Allocation and Apportionment area if needed.

Navigation:Organizer > States > Allocation and Apportionment > Data Entry > Sales Data Entry >
Receipts from Sales

Figure 5:5
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The IRS Form 1120-PC, the USProperty and Casualty Insurance Company Income Tax Return, is filed to
report the income, gains, losses, deductions, credits, and to figure the income tax liability of insurance
companies other than life insurance companies. Life Insurance companies file the Form 1120-L, unless they
are failed life returns. If it is a failed life return, it is filed to the IRS on an 1120-PC return.

1120-PC UNIQUE ITEMS

Loss Reserve Discounting (LRD)
See Loss Reserve Discounting (LRD) (page 36) for more information.

Salvage and Subrogation
See Salvage and Subrogation (page 46) for more information.

Failed Life
See Failed Life (page 31) for more information.

Deferred Acquisition Costs (DAC)
The Deferred Acquisition costs (DAC) are most commonly entered on the 1120-L returns. These are the
expenses incurred when gathering new premiums and amortized under Section 848.

See DAC – Deferred Acquisition Costs (page 32) for more information.

LOSS RESERVE DISCOUNTING (LRD)
LRD has two ways to discount: company experience and treasury experience. The tax software supports the
Treasury basis (IRS) and the Company experience basis calculations, computing the discount factors back to
accident year (AY) +14 years.
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Loss Reserve Discounting (LRD)

The Loss Reserve Discounting (LRD) calculations require the transfer of information from Schedule P of the
Property and Casualty Annual Statement and the company payment pattern calculations also require
information from Schedule P. You can download this information from the NAIC files using either the 1120-PC
and LRD combined transfer or the separate LRD transfer, or you can enter the information into the LRD Annual
Statement screens.

Loss reserves can be discounted using the IRS discount factors or company payment patterns. The system
default for Loss Reserve Discounting uses the IRS factors. A combination of the IRS factors and company
payment pattern can be used. This option is provided by the company’s line of business.

On a title insurance company, we do not calculate the IRS discount factors for the miscellaneous
casualty area.

For company experience basis, the NAIC file can never synchronize with the LRD schedule in Organizer. The
reasons are:

1. The two-year gap between the NAIC Schedule P data and tax. For example, the 2019 imported Schedule
P data is not used for the tax calculation until the 2021 tax year.

2. Company experience basis requires a minimum of five (5) years of a company’s historical payment
pattern data. The current year NAIC Schedule P does not have this.

For example, for a company to use company experience as the basis to discount its loss reserves in the 2021
tax year, it needs data from NAIC Schedule P for tax years 2020, 2019, 2018, 2017, and 2016. To see how our
software calculates LRD using the company experience basis, you need to enter, at a minimum, Schedule P
data for years 2020, 2019, 2018, 2017, and 2016 into Organizer. In real life, our software automatically rolls
over and transfers Schedule P prior year information for you.

LRD Lines
The lines of business can be calculated all by one method or a combination of two methods: the company
payment pattern and/or the IRS payment pattern. The company payment pattern comes from the Annual
Statement transfer. The IRS payment pattern is a compilation of the industry averages. The loss reserves can
be chosen by lines; one calculated by the payment pattern and the other calculated by the IRS payment pattern
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Loss Reserve Discounting (LRD)

Compute Options
Navigation:Organizer > Loss Reserve Discounting > Options > Compute Options

On the Elections tab, select the lines of business and years to discount using company payment pattern on
this tab.

Figure 6:1

The IRS AY+9 tab shows the payment pattern the IRS uses in computing discount factors.

Figure 6:2
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Loss Reserve Discounting (LRD)

The Discounting tab gives you options such as:

l Discount loss reserves separately for accident year’s prior to AT +10.

l Discount loss reserves using only the unpaid losses, column 24 of Sch P.

l Discount International loss reserves using the 10 year method.

l Do not apply the discounted statutory reserve limited (S846).

l Check to discount Other, Credit and AH (Part L).

Figure 6:3

Print Suppression Options
Navigation:Organizer > Loss Reserve Discounting > Options > Print Suppression tab

On theGlobal tab, theGlobal LRD Print Suppression Options allow you to suppress the following items by
selecting the check box:

l Loss Reserve Discounting Summary

l Short and Long period summaries

l All detail

l Company payment pattern detail

l Reserve detail

l Group A&H, Other A&H detail
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Loss Reserve Discounting (LRD)

Figure 6:4

On the Short Period tab, the Short Period Suppression Options allow you to suppress the following:

l Suppress Summary and Detail print items by selecting an item check box.

l SuppressCompany Payment Pattern Detail by Line of Business by selecting an item check box.

l Suppress Reserve Detail by Line of Business by selecting an item check box.
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Loss Reserve Discounting (LRD)

Figure 6:5

On the Long Period tab, the Long Period Suppression Options allow you to suppress the following:

l Suppress Summary and Detail

l SuppressCompany Payment Pattern Detail by Line of Business

l SuppressReserve Detail by Line of Business
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Loss Reserve Discounting (LRD)

Figure 6:6

Discounting Summary
Navigation:Organizer > Loss Reserve Discounting > Discounting Summary > Summary Totals tab

This folder is where most of the LRD data is located.

l Summary Totals tab

l Short Period Lines tab

l Long Period Lines tab

l Accident and Health tab

l IRS Discount Factors tab.
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Loss Reserve Discounting (LRD)

Figure 6:7

SHORTPERIODLINES

For the following short period lines, you can see the amounts from the Company Payment pattern: the Annual
Statement and the Loss Reserve Calculations. The Company Payment Pattern shows the last five years of
data. The Annual Statement section displays information from columns 23, 24, 35, and 36 of Schedule P. The
Loss Reserve Calculation section displays statutory reserves, discounted anticipated Salvage and
Subrogation, and Discounted Loss Reserves for the last two years.

Navigation:Organizer > Loss Reserve Discounting > Discounting Summary > Short Period Lines
tab

Figure 6:8
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Loss Reserve Discounting (LRD)

l Special Property

l Auto Physical Damage

l Fidelity and Surety

l Other (Credit & A&H)

l Financial/ Mortgage Guaranty

LONG PERIODLINES

For the following Long period lines, you can see the amounts from the Company Payment pattern, the Annual
Statement, and the Loss Reserve Calculations. The Company Payment Pattern shows the last fifteen years of
data. The Annual Statement section displays information from columns 23, 24, 35, and 36 of Schedule P. The
Loss Reserve Calculation section displays statutory reserves, discounted anticipated Salvage and
Subrogation, and Discounted Loss Reserves for the last 15 years.

Navigation:Organizer > Loss Reserve Discounting > Discount Summary > Long Period Lines tab

Figure 6:9
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Loss Reserve Discounting (LRD)

l Auto Liability

l Worker’s Compensation

l Multiple Peril

l Medical Professional Liability

l Other Liability

l International

l Reinsurance

l Products Liability

ACCIDENTANDHEALTH

Summary of Group Accident and Health policies unpaid losses.

Navigation:Organizer > Loss Reserve Discounting > Discounting Summary > Accident and Health
tab

Figure 6:10
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Salvage and Subrogation

l Group Accident and Health unpaid losses

l Group Accident and Health LAE expenses

l Other Accident and Health unpaid losses

l Other Accident and Health LAE expenses

l Less: Reserves not eligible for half-year discounting

l * Net Accident and Health Reserves subject to discounting*

l Discount Factor

l Accident and Health discounted reserves

l Accident and Health reserves subject to Morbidity discounting

l Total adjustment for discounting Accident and Health loss reserves

* Statutory reserves from Schedule P, Part L should be adjusted to reflect the amounts represented on line 6
above.

SALVAGE AND SUBROGATION
The Revenue Recognition Act of 1990 (RRA) requires that, for the tax years beginning after 1989, salvage and
subrogation (S&S) recoverable must be included in determination of losses incurred. This provision is required
whether or not an insurer reduced its unpaid losses and loss adjustment expense (LAE) by anticipated S&S
recoverable for statutory accounting purposes. Recoverable amounts include those amounts applicable to paid
and unpaid losses and LAE and are calculated for tax purposes on a discounted basis. Life insurance
companies are not subject to the tax treatment of S&S recoverable.

Salvage is the sale of damaged goods for which the insured has been indemnified by the insurance company.
The most typical example of salvage is when the insurance company sells the remains of a car to which it has
taken title after the insurance settlement with the insured for the total precrash value of the car.

Subrogation is the collection by the insurance company of the amount of a paid claim from a negligent third
party or his insurer. Although subrogation is a liability concept, you might well find that subrogation actually
outweighs salvage even in your company’s auto physical damage experience. For example: to speed claim
settlement, your company has paid for the physical damage of your not-at-fault insureds and then collected
subrogation from the insurance companies of the at-fault drivers.

Salvage Recoverable is the estimated salvage and subrogation (net of expenses) to be recovered on all claims
incurred to date, whether reported or unreported.
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Salvage and Subrogation

Methods of Calculation of Salvage and Subrogation
To calculate the Salvage & Subrogation (S&S) option for the Annual Statement, Schedule P column 24 must be
selected for the amounts to flow from the LRD screens to the S&S discount screens.

Two methods apply when discounting the S&S area:

l Alternative 1: This method uses the industry pattern.

l Alternative 2: This method uses the same factors used to discount unpaid losses.

S&S Options
Navigation:Organizer > Salvage and Subrogation > Options > Compute Options

l Global Calculation Suppression: Two options are available to suppress all salvage and subrogation
calculations and to discount salvage and subrogation separately for accident years prior to AY+10.

Figure 6:11

l Print Suppression Options: Select one of the first two check boxes to suppress various detail
summaries or selectAll detail.

Figure 6:12
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Salvage and Subrogation

l Discounting Summary: This is where the discounting amounts can be seen for the Short and Long
period lines. The IRS Table is also included here for both short and long period lines. It displays the
Salvage Discount factors based on published revenue procedures.

Figure 6:13
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APPLICATION

CROSS-CHECKING OF DATA SOURCE TYPES
When you create the return and choose the data entry method, the insurance application then crosschecks the
return and entity type and gives you a warning of an invalid selection. For example, a company filing an 1120-L
can choose to populate the return through the Electronic Organizer, the Life Annual Statement Transfer, or the
Separate Accounts Annual Statement Transfer.

Below are the entity types and the return types available:

1120-L

l Life Annual Statement

l Separate Accounts Annual Statement

l Electronic Organizer – Data Entry

1120-PC

l Property and Casualty Annual Statement

l Title Annual Statement

l Health Annual Statement

l Electronic Organizer – Data Entry

1120

l Electronic Organizer – Data Entry
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Organizer and Tax Forms

ORGANIZER AND TAX FORMS
The Organizer is the central collection point for all data in a given tax year. The Organizer is initially populated
with balances, adjustments, and calculated amounts that flow from NAIC import, or are entered manually. The
Organizer also stores any supporting schedules and return data that are used to complete the tax return. The
primary type of screens found in the Organizer area are:

l Organizer These screens are used to display data or review the amounts that are imported or entered.
These screens have a gray background and white fields.

l Workpapers These screens reside between the Tax Forms and Organizer screens, and show how
Organizer data is calculated for tax form completion. Workpaper screens are generally shaded with a
yellow background.

l Tax Forms These screens show on-screen reproductions of the tax forms. Tax Form screens have white
backgrounds.

GENERAL INFORMATION
TheGeneral Information folder contains data entry screens that allow you to make selections and customize
the return. This folder also contains options for print, compute, and schedules.

BASICRETURN INFORMATION

Navigation:Organizer > General Information > Basic Return Information > Entity Information

The Entity Information screen displays the companyName, Entity Number, EIN,Address (or Foreign),
Dates, and has sections for the Return/Entity Type, Failed Life Return, and Business Activity
information. We recommend that you visually review and verify this information.

l Business Codes link: Select link to view a Help screen where another link exists to the IRSBusiness
Activity Codes.
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General Information

l Entity Information: For the Electronic Organizer returns, enter the Name as desired that populates the
Tax Return. A check box is provided for Name changes. For Annual Statement returns, the name from
the Annual Statement is automatically filled in on both the federal and state the tax return. Enter the Entity
number in the field provided. The federalEIN is only needed for taxable entities, not divisions,
eliminations, or subconsolidation entities. A check box is provided if EIN isApplied for.

Figure 7:1

l Address: Address information is not required for the eliminations or the subgroup subconsolidation
return. For Annual Statement returns, the federal and state tax return automatically fills in the address that
is shown on the Annual Statement. Included are Address,City, State (drop-down list), and ZIP fields for
domestic addresses with a check box to indicate an Address Change. Foreign addresses include
Province,Country (drop-down list), and Postal Code.

Figure 7:2
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General Information

l Return/Entity Type: Select the return type, entity type, and data source.

Figure 7:3

l Failed Life Return: If the life annual statement is available, select the applicable check box to activate
1120-PC and/or deactivate 1120L.

Figure 7:4

l Date of incorporation: The date is only needed for taxable entities, not divisions or elimination returns.
Select the Pre-1900 hyperlink if the date is before 1900. Enter the Month, Day, and Year of incorporation.
Do not enter dates after 1900 here.

Figure 7:5
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General Information

l Business Activity: Select the Business Codes link to look up the Business Activity Code and enter it in
the field provided. A check box indicates if the business in Inactive. Type in the Principal business
activity and the Product or service.

Figure 7:6
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General Information

RETURNANDPRINTOPTIONS

One of the choices under the Basic Options tab is to enter the number of federal and state returns. You can
make selections to print or suppress reports and summaries and indicate the items printed on every page, on
the attachments, or on non-tax form items.

Navigation:Organizer > General information > Return and Print Options > Basic Options tab

Figure 7:7
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General Information

TAXFORMOPTIONS
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General Information

This page shows calculation options for Schedules D, M-1, M-3, PN, and N.
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General Information

There are also some form calculation check boxes for some forms such as Forms 1118, 1120-W, 1138, 1139,
2220, 4466, and 4562. A check box is provided to print the return with override indicators at the bottom of the
form.

ONESOURCE
1120 INSURANCE GUIDE



58 Chapter 7: Working in the Tax Application

General Information

Navigation:Organizer > General Information > Return and Print Options > Tax Form Options tab
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General Information
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General Information

Figure 7:8

Figure 7:9
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General Information

Figure 7:10

M-3OPTIONS

According to the M-3 rules from the IRS, the M-3 must be filed if the entity has $50 million or more in assets,
which is an increase from $10 million in 2016. If an M-3 is filed, then a Schedule N reconciliation is not required.
For additional M-3 rules and instructions, see www.irs.gov.
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General Information

There are various M-3 options for calculation, print, and suppression of amounts. Select the Schedule M-3
Options link to view the Schedule M-3 options shown below.

Figure 7:11
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General Information

Mixed Group 1120/L/PC Group Entity check box

The entity check boxes at the top of the Schedule M-3 tax form automatically populate for Mixed Group entities.

Navigation: Tax Forms > LNL PC Schedule M-3/Form 8916 > Page 1

Figure 7:12

Global M-3 Automatic Calculation Suppression Check box

There is an option to suppress the automatic calculation of the following items on the Schedule M-3 for 1120,
1120-PC and 1120-L for Annual Statement and Electronic users. If this check box is selected, the automatic
calculations listed are suppressed. However, if you enter amounts in the M-3 Organizer, the amounts flow to
the M-3 as overrides.
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General Information

Navigation:Organizer > Return and Print Options > Tax Form Options. Select the Schedule M-3 link .
On the resultingM-3 Sch Options tab screen, scroll down to the Compute Options section.

Select the See List link to view a list of suppressed items.

Figure 7:13

Select the check box to activate theGlobal M-3 Automatic Calculation Suppress Option.
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Reviewing the Tax Return

Figure 7:14

REVIEWING THE TAX RETURN
We provide different reconciliations to review your tax return amounts such as the comparison of the NAIC
Annual Statement income to the taxable income and the reconciliation of the taxable income to the Schedule M-
3.

RECONCILIATIONSOFTHEANNUAL STATEMENT INCOMETO TAXABLE
INCOME

Worksheets in the Tax Summary reconcile the Annual Statement income to the taxable income. The Tax to A/S
Reconciliation, Income Reconciliation, and Income Tax Return SummaryWorksheets helps you reconcile the
Annual Statement income to the 1120-PC or 1120-L tax return income by displaying any reclassifications, tax
adjustments, and M-1 adjustments.

If you want this reconciliation to consolidate in an 1120-L or 1120-PC subgroup with Annual
Statement returns and Electronic Organizer returns, you must enter amounts on this worksheet.
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Reviewing the Tax Return

Navigation: Tax Forms > Federal > 1120-L Corporate Income Tax Return > Tax Summary. Select one
of the following tabs:

l Tax to A/S Reconciliation

l Income Reconciliation

l Income Tax Return Summary

l Summary Tax Comps

l Reclass Summary

l Federal Tax Forms Summary
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Reviewing the Tax Return

1120-L Tax to A/S Reconciliation Screen

Figure 7:15
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Reviewing the Tax Return

1120-L Income Reconciliation

Figure 7:16
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Reviewing the Tax Return

1120-L Income Tax Summary

Figure 7:17
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Reviewing the Tax Return

1120-L Summary Tax Comps

Figure 7:18
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Reviewing the Tax Return

1120-L Reclass Summary

Figure 7:19
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Reviewing the Tax Return

1120-L Federal Tax Forms Summary

Figure 7:20

Reconciliations of Taxable income to other Schedules

Certain worksheets in the Tax Summary reconcile the taxable income to other tax schedules. The 1120-PC
Taxable Income to Schedule M-1 and Taxable Income to Schedule M-3 Income worksheets, for example, show
the 1120-PC or 1120-L tax return income by displaying any reclassifications, tax adjustments, and M-1
adjustments.
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Reviewing the Tax Return

Navigation: Tax Forms > Federal > 1120-PC Corporate Income Tax Return > Tax Summary. Select
one of the following tabs:

l Income Tax Return Summary (similar to 1120L)

l Tax to A/S Reconciliation (similar to 1120L)

l Taxable Income Reconciliation (see below)

l Federal Tax Forms Summary (similar to 1120L)

1120-PC Taxable Income Reconciliation
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Reviewing the Tax Return

Figure 7:21

DIAGNOSTICS

The system provides diagnostics to help you determine inconsistencies, omissions, or override errors. To
review diagnostics, select View > Diagnostics, and then select the type.

Figure 7:22

In the left pane, the tax application categorizes diagnostics into three types for Federal, States, and Cities
categories:

l Severe: Should be cleared before printing the return (for example, an out-of balance return).

l Informational: Shows special calculations and the effects of overrides (such as schedules matched to
line items of the return). It can also display print and tax return errors that should be addressed before
filing.

l E-file: Three types of e-file diagnostics must be cleared if the return is to be accepted by the IRS or the
state tax departmen

o Electronic Filing – Alerts.

o Electronic Filing – Rejects: Errors the tax application has detected that must be cleared to e-file.

o E-file XML Validation errors: Errors detected after creating the e-file. These must be cleared to
get a qualified return.
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ACTIVATING STATE RETURNS
1120 state returns are activated on the state activation spreadsheet, found when you navigate inOrganizer >
States > State and City Activation > State and City Activation.

For each state, select the check box in column B - State Activation for a single company or consolidated
return member company.

In addition, select the Return Type and Entity Type by selecting the down arrow beside each item to open a
list of options.

Figure 8:1
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Activating State Returns

In a consolidated return, mark states to combine by selecting Combine in the drop-down list in column C.

Figure 8:2

Combine and Active are mutually exclusive options.

Additionally, four states have their own insurance returns:Michigan,Mississippi,New York, andOregon.
Individual state instructions indicate whether an insurance return only is required, or an 1120 state form can
alternatively be used. The State Activation spreadsheet indicates these insurance states in columnG -
Insurance Return Form Typewith an entry of Insurance displayed in the cells. Insurance is the default
selection if the federal return is an 1120-PC or 1120L. The choice of Insurance or C Corporation return is made
at the member company level (that is, at the parent and subsidiary company level), based on the desired state
return form.

Figure 8:3
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Allocation and Apportionment

At any consolidated level, only for New York, the selection of Insurance or C Corporation can be transfered to
the member companies by selecting the Transfer to Members (New York) button at the top of columnG.

For a PC Basic account, only a federal single company return can be filed, which does not include
consolidations or state return. In addition, the Electronic Organizer is the only data source
available for PC Basic users.

ALLOCATION AND APPORTIONMENT
If Schedule T of the Annual Statement is used, amounts automatically flow from Schedule T to the Sales -
Other Receiptsworkpaper. Amounts from Schedule T can be suppressed from flowing to the Allocation and
Apportionment area.

Navigation: Tax Forms > States > Allocation and Apportionment > A&A Detail > [State] > Payroll
and Sales > Other Receipts and Misc. Other

Figure 8:4

ONESOURCE
1120 INSURANCE GUIDE
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A deduction is allowed on the tax return for an amount equal to the aggregate of (1) the net operating loss
(NOL) carryover, plus (2) the net operating loss carry back. The mixed group consolidation has three types of
net operating losses that can be calculated in the return:

l Non-SRLY net operating losses

l SRLY net operating losses

l S382 net operating losses.

Each type of net operating loss has its own Organizer where you can enter the amounts. All entries for each
loss type should be entered in the pertinent taxable entity. Depending on the type of NOL, the amount to be
limited must be entered as well.

Navigation:Organizer > Carryovers, Footnotes, and Invoicing > Carryovers > Computed Carryover
Details. Choose the appropriate tab for carrybacks or carryovers.

NON-SRLY NOL
The amount for the Non-SRLY net operating loss must be entered by year in both of the following columns:
Original NOL and Carryover to XXXX, where XXXX represents the current year. The amounts must be entered
in the lowest level subsidiary or parent return in order to consolidate correctly, and not in the top consolidation
There are screen instructions for amounts to be utilized, mainly for print and rollover purposes. These are
consolidated to the top consolidation return and limited against other subgroup income according to the LNL
eligibility check box, IRS rules, and the Organizer overrides. Non-SRLYNOLS are NOT displayed in the lower
entities tax forms.

Non-SRLYNOLS are displayed in the following tax returns:

l Nonlife subgroup Subconsolidation

l NL top consolidation

l LNL top consolidation.
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SRLY NOL Entry

Navigation:Organizer > Carryovers, Footnotes, and Invoicing > Carryovers > Computed Carryover
Detail > Carryover Detail > Regular NOL > Non-SRLY NOL tab

Figure 9:1

1. Select the check box to suppress the print of original NOL on carryover schedules, if desired.

2. EnterOriginal NOL and Carryover NOL.

3. Enter carryover amounts if NOL occurred before 8/6/1997.

SRLY NOL ENTRY
The amounts for the SRLY net operating losses must be entered by year in both of the following columns,
Original NOL and Carryover to XXXX, where XXXX represents the current year. The amounts must be entered
in the lowest level subsidiary or parent return in order to consolidate correctly, and not in the top consolidation.

The SRLYNOL amounts are displayed in the following tax returns:

l a lower level return where the amount is entered

l the subgroup level

l the NL subgroup Subconsolidation

l the NL top consolidation and the LNL top consolidation.

ONESOURCE
1120 INSURANCE GUIDE



Chapter 9: Net Operating Loss 80

S382 NOL

These amounts are consolidated in the top consolidation and limited to be applied against other subgroup
income according to the LNL eligibility check box.

Read the instructions found on the screen displayed below to determine if you need to enter the amount utilized
(mainly for print and rollover purposes).

Navigation:Organizer > Carryovers, Footnotes, and Invoicing > Carryovers > Computed Carryover
Detail > Carryover Detail > Regular NOL > SRLY NOL tab

Figure 9:2

S382 NOL
The amount for the S382 net operating loss must be entered by year in the taxable entity's parent, subsidiary,
or divcon column. In order for the return to consolidate correctly, enter both the Carryover to XXXX (where
XXXX is the current year) and the Limited amount in the lowest level subsidiary or parent return and not in
the top consolidation return. The limitation must be entered to process accurately. S382 NOLs must be applied
against the income of its entity. Any remainder that results is carried forward and used against next year’s
income. The column labeled Amount Utilized is the override column.
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S382 NOL

S382 NOL amounts are displayed in the following tax returns:

l a lower level return where the amount is entered

l the subgroup level

l the NL subgroup Subconsolidation

l the NL top consolidation (topcon) and LNL top consolidation.

Navigation:Organizer > Carryovers, Footnotes, and Invoicing > Carryovers > Carryover Detail >
Regular NOL > S 382 NOL tab.

Figure 9:3

Enter Carryover NOL and Limited Amount (Mandatory).
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NOL Organization and Rules

NOL ORGANIZATION AND RULES
The following chart details where NOLs are displayed on the tax return.

Figure 9:4

NOL Offsetting Rules and Order
The following list of net operating loss rules provides the order that the rules are applied in a Mixed Group
consolidation. Read each NOL type carefully to fully understand before applying.

l NOL carryovers of the same return type (1120 NOLs, 1120-PC NOLs, OR 1120-L NOLs) must be
absorbed by income of the same return type FIRST. Any carryovers that remain can then be utilized by
other subgroup return types.

l NOLs of the same return type (1120 NOLs, 1120-PC NOLs, OR 1120-L NOLs) are utilized by income of
the same return type FIRST. Any carryovers that remain are utilized by other return type subgroups.

l NOLs are offsetWITHIN each subgroup before being consolidated to the top consolidation return,
according to the IRS rules. The limited amounts are entered in the Organizer, AND the Organizer
overrides are entered also.

l NOLs in the top consolidation are offset according to the IRS rules,

o Limited amounts must be entered in the Organizer for each Life company, and at the LNL level.

o Limitations, such as the 35 percent limitation on Nonlife subgroup losses against Life subgroup
income, are automatically applied when the LNL eligibility is checked for each applicable year of loss.

o The Organizer overrides must be entered.
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NOL Organization and Rules

NOL Organizer Override Rules
The following items are some of the net operating loss rules for entering Organizer overrides. Overrides should
not be entered on the tax form, nor used to accomplish consolidation accuracy. Instead, use the Organizer
fields at each level for entry overrides.

LEVEL FIELD DESCRIPTION NAVIGATION

LOWEST Override column -
see NOL (SRLY,
Non-SRLY, S382)
Organizer entry
screen

In Organizer,
select check box
labeledUnlimited
NOL
computations

Navigate to the override field in the Organizer for
each return type:

l 1120 Organizer > Income and
Deductions > Deductions > Net
Operating Losses section

l 1120-L Organizer > Life Electronic
Organizer > Page 1 - Deductions

l 1120-PC Organizer > PC Electronic
Organizer > Page 2 - Deductions

l 1120-PC Organizer > PC Electronic
Organizer > Page 2 > Schedule A -
Deductions > Miscellaneous
Deductions tabs

SUBGROUP
AND
NONLIFE
SUBGROUP

Override column Navigate to the override field in the Organizer for
each return type:

l 1120 Organizer > Income and
Deductions > Deductions > Net
Operating Losses section

l 1120-L Organizer > Life Electronic
Organize > Page 1 - Deductions

l 1120PC Organizer > PC Electronic
Organizer > Page 2 - Deductions

l 1120-PC Organizer > PC Electronic
Organizer > Page 2 > Schedule A -
Deductions > Miscellaneous
Deductions tabs
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Limitation of Nonlife NOL Against Life Subgroup Income

LEVEL FIELD DESCRIPTION NAVIGATION

TOPCON Overridesmust be
entered in the lower
level fields or
subgroups in the
Organizer.

LIMITATION OF NONLIFE NOL AGAINST LIFE SUBGROUP
INCOME
The limitation of Nonlife NOLs against life subgroup income is done automatically in the tax application. The 35
percent limitation is automatically calculated in the top consolidation of the tax return. The computation is the
lesser of the available Nonlife consolidated NOL or the consolidated life subgroup taxable income after capital
loss offset. This computation is done on the yellow workpaper screen shown below.

Figure 9:5

Steps required to view computation screens

1. Navigate to Tax Forms > Federal > 1120 Life-Nonlife Consolidation > 1120 Corporate Tax
Return.

2. On the 1120, Page 1 tab, navigate to the Tax, Refundable Credits, and Payments section, and find
line 30 - Taxable income. Select the link in the field to take you to the yellow workpaper.

3. Select in the field of item 1 labeled 1120, Page 1, line 28 minus line 29c.
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LNL Eligibility Check Box

4. The Life-Nonlife Consolidated Taxable Incomeworkpaper is displayed. Navigate to item 7 labeled
Consol. OLD or NOL offset (*).

5. Select the link in the field under the Nonlife subgroup column 2, labeled Nonlife against Life, to take
you to the Consolidated subgroup OLD or NOL Utilized workpaper.

6. Navigate to item 2 labeled Limitation on subgroup losses. Select in the field in the Nonlife subgroup
column for the item labeled Nonlife against Life.

7. The Limitation on Nonlife NOL Utilization per Reg. 1.1502-47(m)(4)(x) worksheet is displayed.

LNL ELIGIBILITY CHECK BOX
Nonlife subgroup net operating losses that occur in a Life Nonlife top consolidation by default are NOT offset
against life subgroup income. There is an election for the Nonlife subgroup NOLs to be eligible against life
subgroup income. In order to have the Nonlife subgroup NOLs (1120 and 1120-PC) be offset against any life
subgroup income, you must select a check box to determine for which year the election should be used. This
check box is located in the Nonlife subgroup, Life subgroup, or Life Nonlife top consolidation.
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LNL Eligibility Check Box

Navigation:Organizer > Carryovers, Footnotes and Invoicing > Carryovers > Computed Carryback
Detail > Life-nonlife Carryover Detail > Non-SRLY Eligibility Election (globally)

Figure 9:6
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Examples of NOL Utilization

EXAMPLES OF NOL UTILIZATION

NL Examples

NL NOL 1120 PARENT WITH NON SRLY NOL $5,000

1120 SUBGROUP TAX RETURN 1120 SUBGROUP 1120 PARENT ELIM.

TAXABLE INCOME BEFORE NOL 4,004,000 4,004,000 0

LESS NOL _________ _________

LESS SPECIAL DEDUCTION 4,000 4,000 0

TOTAL NOL AND DEDUCTION 4,000

_______

4,000

________

0

________

TOTAL NOL AND DEDUCTIONS 4,000,000 4,000,000 0

Comment: The Non-SRLY NOL are utilized in the topcon (see below)

NL CONSOL. WORKSHEET NL CONSOL. ADJUSTMENTS 1120 SUBGROUP PC SUBGROUP

TAXABLE INCOME BEFORE NOL 6,006,000 4,004,000 2,002,000

LESS NOL 5,000 5,000 None 0

LESS SPECIAL DEDUCTION 6,000 4,000 2,000
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Examples of NOL Utilization

NL CONSOL. WORKSHEET NL CONSOL. ADJUSTMENTS 1120 SUBGROUP PC SUBGROUP

TOTAL NOL AND DEDUCTION 4,000

________

4,000

________

4,000

________

0

________

TOTAL NOL AND DEDUCTIONS 11,000 5,000 4,000 2,000

TAXABLE INCOME 5,995,000 (5,000) 4,000,000 2,000,000

NL NOL 1120 PARENT WITH NON-SRLY $5,000, $100 SRLY & $382 SECTION
382 NOL

1120 SUBGROUP TAX RETURN 1120 SUBGROUP 1120 PARENT ELIM.

TAXABLE INCOME BEFORE
NOL 4,004,000 4,004,000 0

LESS NOL 482 482

LESS SPECIAL DEDUCTION 4,000 4,000 0

TOTAL NOL AND DEDUCTION 4,482

_______

4,482

________

0

________

TOTAL NOL AND DEDUCTIONS 3,999,518 3,999,518 0

Comment: The Non-SRLY NOL are utilized in the topcon (see below)
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Examples of NOL Utilization

NL CONSOL. WORKSHEET NL CONSOL. ADJUSTMENTS 1120 SUBGROUP PC SUBGROUP

TAXABLE INCOME BEFORE NOL 6,006,000 4,004,000 2,002,000

LESS NOL 5,482 5,000 482 0

LESS SPECIAL DEDUCTION 6,000 4,000 2,000

TOTAL NOL AND DEDUCTION 4,000

________

4,000

________

4,000

________

0

________

TOTAL NOL AND DEDUCTIONS 11,482 5,000 4,482 2,000

TAXABLE INCOME 5,994.518 (5,000) 3,999,518 2,000,000

NL NOL 1120 PARENT WITH NON-SRLY $5,000, $100 SRLY & $382 SECTION 382
NOL, AND PC SUBGROUP WITH $1382 SECTION 382 NOL

1120 SUBGROUP TAX
RETURN

1120 SUBGROUP 1120 PARENT ELIM.

TAXABLE INCOME BEFORE
NOL 4,004,000 4,004,000 0

LESS NOL 482 482

LESS SPECIAL DEDUCTION 4,000 4,000 0

TOTAL NOL AND
DEDUCTION 4,000

_______

4,000

________

0

________
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Examples of NOL Utilization

NL NOL 1120 PARENT WITH NON-SRLY $5,000, $100 SRLY & $382 SECTION 382
NOL, AND PC SUBGROUP WITH $1382 SECTION 382 NOL

1120 SUBGROUP TAX
RETURN

1120 SUBGROUP 1120 PARENT ELIM.

TOTAL NOL AND
DEDUCTIONS 3,999,518 3,999,518 0

Comment: The Non-SRLY NOL are utilized in the topcon (see below)

NL NOL 1120 PARENT WITH NON-SRLY $5,000, $100 SRLY & $382 SECTION 382
NOL, AND PC SUBGROUP WITH $1382 SECTION 382 NOL

1120 SUBGROUP TAX
RETURN

1120 SUBGROUP 1120 PARENT ELIM.

TAXABLE INCOME
BEFORE NOL 2,002,000 2,002,000 0

LESS NOL 1,382 1,382

LESS SPECIAL
DEDUCTION 2,000 2,000 0

TOTAL NOL AND
DEDUCTION 3,382

_______

3,382

________

0

________

TOTAL NOL AND
DEDUCTIONS 1,998,618 1,998,618 0

Comment: The Non-SRLY NOL are utilized in the topcon (see below)
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Examples of NOL Utilization

NL CONSOL. WORKSHEET NL CONSOL. ADJUSTMENTS 1120 SUBGROUP PC SUBGROUP

TAXABLE INCOME BEFORE NOL 6,006,000 4,004,000 2,002,000

LESS NOL 6,864 5,000 482 0

LESS SPECIAL DEDUCTION 6,000 4,000 2,000

TOTAL NOL AND DEDUCTION 4,000

________

4,000

________

4,000

________

0

________

TOTAL NOL AND DEDUCTIONS 12,864 5,000 4,482 3,382

TAXABLE INCOME 5,993,136 (5,000) 3,999,518 1,998,618

LNL Examples

LNL NOL 1120 PARENT WITH $5,000 NON-SRLY, $100 SRLY & $382 SECTION 382 NOL, PC
SUBGROUP WITH $1382 SECTION 382 NOL, AND LIFE SUBGROUP WITH $10,382
SECTION 382 NOL

1120 SUBGROUP
TAX RETURN

1120 SUBGROUP 1120 PARENT ELIM.

TAXABLE
INCOME BEFORE
NOL

4,004,000 4,004,000 0

LESS NOL 482 482

LESS SPECIAL
DEDUCTION 4,000 4,000 0

ONESOURCE
1120 INSURANCE GUIDE



Chapter 9: Net Operating Loss 92

Examples of NOL Utilization

LNL NOL 1120 PARENT WITH $5,000 NON-SRLY, $100 SRLY & $382 SECTION 382 NOL, PC
SUBGROUP WITH $1382 SECTION 382 NOL, AND LIFE SUBGROUP WITH $10,382
SECTION 382 NOL

1120 SUBGROUP
TAX RETURN

1120 SUBGROUP 1120 PARENT ELIM.

TOTAL NOL AND
DEDUCTION 4,482

_______

4,482

________

0

________

TOTAL NOL AND
DEDUCTIONS 3,999,518 3,999,518 0

Comment: The Non-SRLY NOL are utilized in the topcon (see below)

LNL NOL 1120 PARENT WITH $5,000 NON-SRLY, $100 SRLY & $382 SECTION 382 NOL, PC
SUBGROUP WITH $1382 SECTION 382 NOL, AND LIFE SUBGROUP WITH $10,382
SECTION 382 NOL

PC SUBGROUP
TAX RETURN

PC SUBGROUP PC PARENT PC ELIM.

TAXABLE
INCOME BEFORE
NOL

2,002,000 2,002,000 0

LESS NOL 1,382 1,382

LESS SPECIAL
DEDUCTION 2,000 2,000 0

TOTAL NOL AND
DEDUCTION 3,382

_______

3,382

________

0

________

TOTAL NOL AND
DEDUCTIONS 1,998,618 1,998,618 0

Comment: The Non-SRLY NOL are utilized in the topcon (see below)
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Examples of NOL Utilization

LNL NOL 1120 PARENT WITH $5,000 NON-SRLY, $100 SRLY & $382 SECTION 382 NOL, PC
SUBGROUP WITH $1382 SECTION 382 NOL, AND LIFE SUBGROUP WITH $10,382
SECTION 382 NOL

LIFE SUBGROUP
TAX RETURN

LIFE SUBGROUP LIFE PARENT LIFE ELIM.

TAXABLE
INCOME BEFORE
NOL

1,001,000 1,001,000 0

LESS NOL 10,382 10,382

LESS SPECIAL
DEDUCTION 1,000 1,000 0

TOTAL NOL AND
DEDUCTION 11,382

_______

11,382

________

0

________

TOTAL NOL AND
DEDUCTIONS 989,618 989,618 0

Comment: The Non-SRLY NOL are utilized in the topcon (see below)

LNL CONSOL.
WORKSHEET

LNL
CONSOL.

ADJUSTMENTS 1120
SUBGROUP

PC
SUBGROUP

LIFE
SUBGROUP

TAXABLE INCOME
BEFORE NOL 7,007,000 4,004,000 2,002,000 1,001,000

LESS NOL 17,246 5,000 482 1,382 10,382

LESS SPECIAL
DEDUCTION 6,000 4,000 2,000 1,000
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Common NOL Support Questions

LNL CONSOL.
WORKSHEET

LNL
CONSOL.

ADJUSTMENTS 1120
SUBGROUP

PC
SUBGROUP

LIFE
SUBGROUP

TOTAL NOL AND
DEDUCTION 7,000

________ ________

4,000

________

0

________

0

________

TOTAL NOL AND
DEDUCTIONS 24,246 5,000 4,482 3,382 11,382

TAXABLE INCOME 6,982,754 (5,000) 3,999,518 1,998,618 989,618

COMMON NOL SUPPORT QUESTIONS
Q: How do I suppress the NOL carryover statement from printing for the sub members?

A: Navigate toOrganizer > Consolidated Returns > Step 3 > Form Print Options. Select the check box
to suppress 1120 on the Page 1 NOL detail for both parent and all subsidiaries.

Q: How do I print the NOL statement? The statement is not printing correctly.

A: Depending on the type of NOL (there are three types), utilization and print of Non- SRLYNOL are at the
topcon level. If NOLs have been entered, check if overrides are entered used in the Organizer.

Q: How do I print the NOL SRLY NOL schedule? It is not printing on the form.

A: The utilization and print of Non-SRLYNOL is at the topcon level. If the non-SRLYNOL schedule is not
printing on the form, enter NONE if no amount is present (if applicable).

Q: Do the federal NOL amounts flow to the states schedules?

A: Yes, they flow automatically from the federal area to the states.
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Common NOL Support Questions

Q: How do I correct the S382 NOL? The S382 NOL is not flowing to the topcon and/or not utilizing
the correct amount.

A: For S382 NOLs, the limited amount in the Organizer must also be entered. Navigate toOrganizer >
Carryovers, Footnotes, and Invoicing > Carryovers > Computed Carryover Detail > Carryover
Detail > Regular NOL > S 382 NOL tab

Q: Why is the NOL not being limited by income?

A: Navigate toOrganizer > Income and Deductions > Deductions > Detail, and clear the check box
labeled Unlimited NOL computations.

Q: Where can I override my NOL?

A: First check if entry of NOL is correct in lowest level (parent or subsidiary) and not in the topcon level.
Overrides should be entered inOrganizer > Income and Deductions > Deductions. Choose the type of
NOL field to override.

Q: Where is the check box to allow unlimited NOL computations?

A: Navigate to Organizer > Income and Deductions > Deductions, and locate the NOL section.
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RETURN

PREPARING FOR CONSOLIDATION
Before beginning any consolidations, all individual company returns should be completed and balanced.
Ensure that the return/entity type is marked correctly in each return. All of the components for the consolidation
must be prepared before beginning the consolidation process, which includes entering the company data in the
1120, 1120-PC, and 1120-L tax returns. If states are to be consolidated, the particular states to be consolidated
must be activated in every return in the consolidation (even if it is not filed by a particular company) in the state
Organizer Add/Delete screen.

ELIMINATION RETURN
Every consolidation group must have an elimination return. All inter-company transactions to be eliminated for
tax purposes are entered in the elimination return.

Nonlife eliminating entries can be entered using the same 1120 subgroup's Income/Deductions and Schedule
M-3 screens.

Elimination entries are made at the Nonlife and subgroup company level. The software does not
support elimination adjustments at the Life-Nonlife level.

Types of Elimination Returns
l LNL topcon elimination

l NL elimination

l Subgroup eliminations.

NONLIFEELIMINATION

The Nonlife return has an elimination company in which intercompany entries can be made between the 1120
and the 1120-PC returns. These elimination entries are made in the NL elimination entry screens. There are
limited data entry fields in the Nonlife elimination return. The Nonlife elimination return is not included in the e-
file sent to the IRS, but it does consolidate to the top level consolidation.
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Subgroup Consolidation

INSURANCECONSOLIDATIONSSTEP 2 - ELIMINATING ENTRIES

In the Nonlife EliminationOrganizer, you have to choose the proper return entity tab to enter data, 1120 or
1120-PC. The following screens have fields available to enter data:

l 1120 Income &Deductions

l 1120 Balance Sheet (beginning and ending balances)

l 1120 M-1 &M-2

l 1120 M-3 Part II & III

l 1120-PC Income &Deductions

l 1120-PC Balance Sheet (beginning and ending balances)

l 1120-PCM-1 &M-2

l 1120-PCM-3 Part II & III

SUBGROUPELIMINATION

Each subgroup Subconsolidation has its own subgroup Elimination return. The elimination return type matches
the subgroup return type 1120, 1120-L or 1120-PC. Subgroup elimination returns are there to make the
intercompany and elimination entries for the subgroup.

Only the topmost subgroup Elimination of each return type is included in the e-file.

SUBGROUP CONSOLIDATION

1120 Subgroup Subconsolidation
The topmost 1120 subgroup Consolidation is consolidated in a Nonlife subgroup or top consolidation (topcon)
and is then included in the e-file. You can have many lower 1120 subgroups included (there is no limit) in the
topmost 1120 subgroup, but they are not included in the e-file. Only the one topmost 1120 subgroup is allowed
in e-file. All entities in theWhat to Consolidate listing must be of the 1120 return type. Do not mix entity types
within a subgroup.
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Subgroup Consolidation

Types of 1120 Subgroup Subconsolidations

The 1120 subgroup can have any of the following structures.

If the entities share the same tax ID number, create a Divcon. The returns listed are divisions. The tax ID is on
the Divcon.

DIVCON RETURN

PARENT SLOT Division

ELIMINATION SLOT Subgroup Elimination

SUBSIDIARY SLOT Division

If there are several 1120 subsidiaries and 1120 subgroups to be consolidated together:

1120 SUBGROUP

PARENT SLOT 1120 Subsidiary or Subgroup

ELIMINATION SLOT 1120 Subgroup Elimination

SUBSIDIARY SLOT(S) 1120 Subsidiary or Subgroup

If there are several 1120 subsidiaries to be consolidated together:

1120 SUBGROUP

PARENT SLOT 1120 Subsidiary

ELIMINATION SLOT 1120 Subgroup Elimination

SUBSIDIARY SLOT(S) 1120 Subsidiary

If there is ONLY one 1120 subsidiary in the entire consolidation:

1120 SUBGROUP

PARENT SLOT 1120 Subsidiary

ELIMINATION SLOT 1120 Subgroup Elimination

SUBSIDIARY SLOT
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Subgroup Consolidation

Steps to Complete an 1120 Topmost Subgroup

1. Create the 1120 topmost 1120 subgroup return.

2. Go toOrganizer > Insurance Consolidations > 1120 Subgroup Consolidation Wizard > Step 2 -
What to Consolidate.

3. Enter the applicable parent, elimination, and subsidiaries according to the above structures.

4. Compute all subsidiaries if necessary. If you make any changes to the lower entities, you must recompute
them and reconsolidate.

5. Consolidate.

1120-PC Subgroup Subconsolidation
ALL 1120-PC returns must be combined in an 1120-PC Subgroup Consolidation. Even if there is only ONE
1120-PC individual company in the entire consolidation, a subgroup is required.

The topmost 1120-PC Subgroup Consolidation is consolidated into a Nonlife subgroup or top consolidation.
You can have many lower 1120-PC subgroups included (there is no limit) in the topmost 1120-PC subgroup,
but they are not included in the e-file per the IRS schema rules. Only the one topmost 1120-PC subgroup is
allowed in the e-file. All entities in theWhat to Consolidate listing must be of the 1120-PC-type of return.Do
not mix entity types in a subgroup subconsolidation.

Types of 1120-PC Subgroup Subconsolidations

The 1120-PC subgroup can have the following three examples in theWhat to Consolidate listing.

If your parent is in this group and a 1120-PC, your NL or LNL top consolidation must be a 1120-PC
and is not allowed to e-file yet.

If there are several 1120-PC subsidiaries and/or subgroups to be consolidated together:

1120-PC SUBGROUP

PARENT SLOT 1120-PC Subsidiary or Subgroup

ELIMINATION SLOT 1120 Subgroup Elimination

SUBSIDIARY SLOT(S) 1120-PC Subsidiary/or Subgroup
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Subgroup Consolidation

If there are several 1120-PC subsidiaries to be consolidated together:

1120-PC SUBGROUP

PARENT SLOT 1120 PC Subsidiary

ELIMINATION SLOT 1120 PC Subgroup Elimination

SUBSIDIARY SLOT(S) 1120 PC Subsidiary

If there is ONLY one 1120-PC subsidiary in the entire consolidation:

1120-PC SUBGROUP

PARENT SLOT 1120-PC Subsidiary

ELIMINATION SLOT 1120 1120-PC Subgroup Elimination

SUBSIDIARY SLOT Blank

Steps to Complete an 1120-PC Topmost Subgroup

1. Create the 1120-PC topmost 1120 subgroup return.

2. Go toOrganizer > Insurance Consolidations > 1120-PC subgroup Consolidation Wizard > Step
3 - What to Consolidate.

3. Enter the applicable parent, elimination, and subsidiaries according to the above structures.

4. Compute all subsidiaries if necessary. If you make any changes to the lower entities, you must recompute
and reconsolidate.

5. Consolidate.

1120-L Subgroup Subconsolidation
ALL 1120-L returns must be combined in an 1120-L subgroup Consolidation. Even if there is only ONE
1120-L individual company in the entire consolidation, a subgroup is required for the tax product.
The topmost 1120-L subgroup consolidation is consolidated with a Nonlife subgroup into the Life Nonlife
topcon. You can have many lower 1120-L subgroups included (there is no limit) in the topmost 1120-L
subgroup, but they are not in the e-file. Only the topmost 1120-L subgroup is allowed in the e-file. All entities in
theWhat to Consolidate listing must be of the 1120-L return type.Do not mix entity types.
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Subgroup Consolidation

Types of 1120-L Subgroup Subconsolidation Structures

The 1120-L subgroup can have any of the following structures. If your parent is in this group and is an 1120-L
return type, then your LNL top consolidation must be an 1120-L return type and is not allowed to e-file yet.

If the entities share the same tax ID number, create a Divcon. The returns listed are Divisions. This is the
case for the Life Annual Statement return and the Separate Accounts statement because they usually share the
same tax ID number. The tax ID is on the Divcon.

DIVCON RETURN

PARENT SLOT Division

ELIMINATION SLOT Subgroup Elimination

SUBSIDIARY SLOT Division

If there are several 1120-L subsidiaries and 1120-L subgroups to be consolidated together:

1120-L SUBGROUP

PARENT SLOT 1120-L Subsidiary or Subgroup

ELIMINATION SLOT 1120-L Subgroup Elimination

SUBSIDIARY SLOT(S) 1120-L Subsidiary or Subgroup

If there are several 1120-L subsidiaries to be consolidated together:

1120-L SUBGROUP

PARENT SLOT 1120-L Subsidiary

ELIMINATION SLOT 1120-L Subgroup Elimination

SUBSIDIARY SLOT(S) 1120-L Subsidiary

If there is ONLY one 1120-L subsidiary in the entire consolidation:

1120-L SUBGROUP

PARENT SLOT 1120-L Subsidiary
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Subgroup Consolidation

1120-L SUBGROUP

ELIMINATION SLOT 1120-L Subgroup Elimination

SUBSIDIARY SLOT Blank

Steps to Complete an 1120-L Topmost Subgroup

1. Create the 1120-L topmost 1120-L subgroup return.

2. Go toOrganizer > Insurance Consolidations > 1120-L subgroup Consolidation Wizard > Step 3
- What to Consolidate.

3. Enter the applicable parent, elimination, and subsidiaries according to the above structures.

4. Compute all subsidiaries if necessary. If you make any changes to the lower entities, you must recompute
and reconsolidate.

5. Consolidate.

Subgroup Top Consolidation
This is NOT a Mixed Group filing. This consolidation contains entities that are all of one type of return. If multiple
1120-PCs (and no 1120 or 1120-L returns) file to the IRS together, your top consolidation is an 1120-PC
subgroup top consolidation. If multiple 1120-Ls (and no 1120 or 1120-PC returns) file to the IRS together, your
top consolidation is an 1120-L subgroup top consolidation.

While this return resembles a subgroup Subconsolidation, it is an Insurance top consolidation that can file to the
IRS by print only. The IRS does not yet accept e-file for this return type.

Types of Subgroup Top Consolidation Structures

These are the following possible structures for a subgroup top consolidation.

If all entities in the consolidation are 1120-PCs, then the example would be:

PARENT SLOT 1120-PC Subgroup/Parent

ELIMINATION SLOT 1120-PC Elimination

SUBSIDIARY SLOT 1120-PC Subgroup/Parent
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Nonlife Consolidation

If all entities in the consolidation are 1120-Ls, then the example would be:

PARENT SLOT 1120-L Subgroup/Parent

ELIMINATION SLOT 1120-L Elimination

SUBSIDIARY SLOT 1120-L Subgroup/Parent

NONLIFE CONSOLIDATION
Amixed group consolidation that consists of 1120 and 1120-PC returns ONLY is a Nonlife Consolidation. It
cannot contain any other return type. If you have other subsidiaries in your company structure, they must be
combined in the subgroups. The IRS rules designate that an 1120 subgroup return and an 1120-PC subgroup
return consolidate together. Return types must be grouped together.

Only the following Nonlife Structures correctly compute, print, and create an e-file in the tax application. If you
are creating a Nonlife subgroup to be further consolidated with a Life subgroup into a Life Nonlife top
consolidation, you must set up the structure correctly.

Nonlife Subgroup or Nonlife Top Consolidation
The Nonlife consolidation can ONLY contain THREE entities on the Subsidiary Listing (see below) of theWhat
to Consolidate listing. The structures are the same for the Nonlife subgroup and the Nonlife top consolidation.
There are only two structures for a Nonlife subgroup or Nonlife top consolidation.

Types of Nonlife Structures

The Nonlife consolidation can ONLY contain THREE entities. The structures are the same for the Nonlife
subgroup and the Nonlife top consolidation. The Nonlife can have the following examples:

If the parent is an 1120, the example would be:

PARENT SLOT 1120 Topmost Subgroup

ELIMINATION SLOT 1120 Nonlife Elimination

SUBSIDIARY SLOT 1120-PC Topmost Subgroup
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Nonlife Consolidation

If the parent is an 1120-PC, then the example would be:

PARENT SLOT 1120-PC Topmost Subgroup

ELIMINATION SLOT 1120-PC Nonlife Elimination

SUBSIDIARY SLOT 1120 Topmost Subgroup

Complete theWhat to Consolidate Subsidiary listing with all 1120-L entities.

If the Nonlife subgroup (to be consolidated in a LNL top consolidation) has only an 1120-PC subgroup return
and no 1120 subgroup, then the example would be:

PARENT SLOT 1120 Topmost Subgroup

ELIMINATION SLOT 1120 -PC Subgroup Elimination

SUBSIDIARY SLOT BLANK

Steps to Complete a Nonlife Return

1. Create the Nonlife top consolidation or subgroup return.

2. Go toOrganizer > Insurance Consolidations > Nonlife Consolidation Wizard > Step 2 - What to
Consolidate.

3. Enter the applicable parent, elimination, and subsidiaries according to the above structures.

4. Compute all subsidiaries if necessary. If you make any changes to the lower entities, you must recompute
and reconsolidate.

5. Consolidate.

Consolidation Review

After consolidation, you can review the results and verify the company’s taxable income on this screen. It lists
each entity, return type, and taxable income. Only parent, subsidiary, and elimination returns transfer;
subgroup subconsolidation returns do not transfer.
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Life Nonlife Consolidation

LIFE NONLIFE CONSOLIDATION
Amixed group consolidation that consists of 1120, 1120-PC, and 1120-L returns is a Life Nonlife Consolidation.
It cannot contain any other return type. If you have other subsidiaries in your company structure, they must be
combined in one of the three subgroups. Return types must be grouped together.

Only the following Life Nonlife Structures correctly compute, print, and e-file in the tax application.

Types of Life Nonlife Structures

The Life Nonlife consolidation can ONLY contain THREE entities. The Life Nonlife can have the following
examples.

If the parent is an 1120, then the example would be:

PARENT SLOT 1120 Nonlife Subgroup

ELIMINATION SLOT 1120 LNL Elimination

SUBSIDIARY SLOT 1120-L Topmost Subgroup

If the parent is an 1120-PC, then the example would be:

PARENT SLOT 1120-PC Nonlife Subgroup

ELIMINATION SLOT 1120-PC Elimination

SUBSIDIARY SLOT 1120-L Topmost Subgroup

If the parent is an 1120-L, then the example would be:

PARENT SLOT 1120-L Nonlife Subgroup

ELIMINATION SLOT 1120 Elimination

SUBSIDIARY SLOT 1120 or 1120-PC Topmost Subgroup
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Tools for Consolidation

If the Nonlife subgroup does not include a PC subgroup:

You MUST create a PC subgroup that includes a blank PC subsidiary and blank PC elimination. This is then
consolidated with the 1120 subgroup in the Nonlife subgroup Subconsolidation. If the PC subgroup is omitted,
the result in a nonqualified XML file.

TOOLS FOR CONSOLIDATION

Subview
Subview has been modified to go directly to the lower entities.

Subview gives easier access to the members of consolidated returns and is used for reconciliation of
consolidated returns. In any consolidated return, select any field and select Subview to view the entities,
amounts, and adjustments, if any, that make up that consolidated number. A dialog box then shows you entities
that consolidate to the current field. To see a specific entity, highlight or select the item, and the screen jumps to
that entity, while still maintaining the consolidation.
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Form 851: Corporate Affiliations Schedule

Through the Windows option at the top of the screen, you can choose entities you have opened using
Subview. When you are finished with a particular entity, close it using the red X in the upper left corner below
the file option. After using Subview, you must complete the consolidation as usual at each consolidated level if
any changes were made to any entity in that consolidation.

Figure 10:1

Schedule K Questions
The software pulls Schedule K information from the parent company. On a Nonlife or Life-Nonlife return, this
information comes from the subgroup Schedule K that contains the parent company.

FORM 851: CORPORATE AFFILIATIONS SCHEDULE

Preparing Form 851
Form 851 is printed from the top consolidation return, but consists of information entered in the parent and
subsidiary returns. To create the 851 correctly, it is important to know where to enter information for each field
and section of the form. These instructions lead you through that process.
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Form 851: Corporate Affiliations Schedule

Generally, information for the 851 comes from these three places: the top consolidation return, the parent
return, and the subsidiary returns. When you create a consolidation return, select the active members to be
included in the consolidation on theWhat to Consolidate screen. The program can now transfer in certain
information from the entities you have listed. The corporation name, address, FEIN, estimated and extension
payments, Principal Business Activity, and PBA code information is carried in from theGeneral Information
area in the respective parent and subsidiary returns.

Consolidation Carry Information
We call the information that transfers into the top consolidation from other returns consolidation carry
information. Every time you perform a consolidation, the program sweeps the parent and subsidiary returns to
collect the Consolidation Carry Information.

Be careful not to enter any of this information in the top consolidation’s Organizer or Tax Forms. If
you manually enter any data in these fields, the application overwrites this information each time
you consolidate, when it transfers the Consolidation Carry Information into the Organizer.

First we look at what information comes from which return, and then go through the form field-by-field, and list
the source for the data. In general, the following information transfers from the returns shown.

Parent

The following information carries automatically to the top consolidation return from the parent. To have this
transfer take place, you must enter the company locator numbers on the top consolidation return inOrganizer
> Consolidated Returns > What to Consolidate screen.

l Name and address (street, city, state, zip code)

l Tax year ending

l Employer identification number

l Prepayment credits

l PBA (Principal Business Activity) Code number.
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Form 851: Corporate Affiliations Schedule

Subsidiaries

The following information carries automatically to the top consolidation return from the subsidiary returns:

l Names and addresses

l Employer identification numbers

l Prepayment credits

l Principal business activity

l PBA code numbers.

Top Consolidation
Enter the following information in the top consolidation return:

Inactive Subsidiary Information

If you do not prepare returns for inactive members of the consolidation, you can add these members to your
Form 851 on the top consolidation return. This information carries to Part I of the Form 851 tax return.

1. In the top consolidation return, accessOrganizer > Informational Forms > Affiliation Schedule >
Inactive Subsidiary Information.

2. Enter the name, address, FEIN, and PBA information for each inactive member company.

3. Be sure to assign the first inactive subsidiary a company number that follows the last number assigned to
active subsidiaries on the Consolidated Returns > What to Consolidate > Consolidation Locator
List screen.

Voting Stock Information

Enter your company number, the PBA activity, and the code appears.

Part III and Part IV Information

Enter Parent and Subsidiary information for Parts III and IV of Form 851.

Entering Information for Form 851
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Form 851: Corporate Affiliations Schedule

Part I

For Part I, the following tables indicate where information is entered.

Page 1, top section: General Information

FORM 851 ITEM WHERE TO ENTER IN ORGANIZER

IN THE PARENT RETURN

Common Parent corporation
name

General Information > Basic Return Information > Entity
Information tab

Address General Information > Basic Return Information > Entity
Information tab

FEIN General Information > Basic Return Information > Entity
Information tab

Tax year end General Information > Basic Return Information > Entity
Information tab

For Part I, the following shows where information is entered.

FORM 851 ITEM WHERE TO ENTER IN ORGANIZER

IN THE TOP CONSOLIDATION RETURN

CompanyNumber Consolidated Returns > What to Consolidate

IN THE PARENT RETURN

Portion of Form 7004 tax deposits Payments and Extensions > Payment of Taxes

Portion of estimated tax credits and
deposits

Payments and Extensions > Payment of Taxes

IN SUBSIDIARY RETURNS

Name and address of corporation General Information > Basic Return Information > Entity
Information tab

Employer identification number General Information > Basic Return Information > Entity
Information tab
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Form 851: Corporate Affiliations Schedule

FORM 851 ITEM WHERE TO ENTER IN ORGANIZER

Portion of Form 7004 tax deposits Payments and Extensions > Payment of Taxes

Portion of estimated tax credits and
deposits

Payments and Extensions > Payment of Taxes

If you enter payments on Form 851 in the top consolidation return, these amounts override the
carry information.

FORM 851 ITEM WHERE TO ENTER IN ORGANIZER

IN THE TOP CONSOLIDATION RETURN

CompanyNumber(s) Informational Forms > Affiliations Schedule > 851
Page 1

Did the subsidiarymake any non dividend
distributions?

Informational Forms > Affiliations Schedule > 851
Page 1

Stock holdings at beginning of year

Number of shares

Percent of voting power

Percent of value

Owned by corporation number

Informational Forms > Affiliations Schedule > 851
Page 1

IN THE PARENT RETURN

PBA CodeNumber General Information > Questions

IN SUBSIDIARY RETURNS

Principal business activity (PBA) General Information > Questions

PBA CodeNo. General Information > Questions
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Form 851: Corporate Affiliations Schedule

Part III: Changes in Stock Holdings During the Year

You are not required to complete Part III for all members of the affiliated group. Therefore, we default to leaving
this part blank. If the affiliated group has members who must complete Part III, enter the following information to
the Organizer screens:

FORM 851 ITEM WHERE TO ENTER IN ORGANIZER

IN THE TOP CONSOLIDATION RETURN

CompanyNumber(s) Informational Forms > Affiliations
Schedule > 851 Page 2

Stockholder (Corporation No.) Informational Forms > Affiliations
Schedule > 851 Page 2

Change in stock holdings during the year
Date

(a) Changes
Shares Acquired
SharesDisposed of

(b) Shares held after changes described in Column (a)
Percent of voting power
Percent of value

Informational Forms > Affiliations
Schedule > 851 Page 2

If the equitable owners of any capital stock shown above were
other than the holders of record, give full details

Informational Forms > Affiliations
Schedule > 851 Page 2
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Form 851: Corporate Affiliations Schedule

Part IV: Additional Information

You are not required to complete Part IV for all members of the affiliated group. Therefore, we default to leaving
this part blank. If the affiliated group has members who must complete Part IV, enter the following information
on the Organizer screens:

FORM 851 ITEM WHERE TO ENTER IN ORGANIZER

IN THE TOP CONSOLIDATION RETURN

Question 1

Company number(s)

Answer to Question 1

If yes, list and describe each class of stock

Informational Forms > Affiliations
Schedule > 851 Page 3

Question 2

Company number(s)

Answer to Question 2

If yes for any part of question 2, list and explain the
circumstances

Informational Forms > Affiliations
Schedule > 851 Page 3

Question 3

Company number(s)

Answer to Question 3

Item 3a, 3b, 3c

Item 3d – description of arrangements

Informational Forms > Affiliations
Schedule > 851 Page 3
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Form 851: Corporate Affiliations Schedule

Printing Form 851
Form 851 has been changed to print only on the top consolidation; it does not print on the subgroup, subcon, or
divcon.

The system does not transfer Part III and IV information from members. This information must be entered on
the top consolidation.

Part III

Figure 10:2
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Form 851: Corporate Affiliations Schedule

Part IV

Figure 10:3
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CHAPTER 11: MIXED GROUP STATE
CONSOLIDATION
There are two different structures of setting up a mixed group state consolidation return:

l multitier structure

l single tier or flat consolidation structure

MULTI-TIER MIXED GROUP STATE CONSOLIDATION
STRUCTURES
Similar to the federal mixed group consolidation, this structure includes a topmost 1120 subgroup, a topmost
1120-PC subgroup, and if applicable, a topmost 1120-L subgroup. The 1120 topmost subgroup is consolidated
with the 1120-PC onto a nonlife topcon (or subcon if there is an 1120-L subgroup in the consolidation). Then, if
applicable, the nonlife subgroup is consolidated with the topmost 1120-L subgroup into a life-nonlife
consolidation.

Figure 11:1
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Single-Tier or Flat Mixed Group State Consolidation Structure

SINGLE-TIER OR FLAT MIXED GROUP STATE
CONSOLIDATION STRUCTURE
This structure should be used only for mixed group state consolidation returns. The state combined includes
one nonlife top consolidation, one nonlife elimination, and all underlying 1120, 1120-PC, and 1120-L
companies. There should be no mid-level subgroup subconsolidations with this structure. This state combined
allows every underlying company to be shown on the top consolidation return. It is designed to be used for
states, such as Illinois and California.

l Illinois requires every underlying company to be shown on its Schedule UB.

l The California form requires that both the income and deductions be shown for every underlying
company.

This structure should also be used for those states that do not allow subgroup subconsolidations.

Figure 11:2

NONLIFE ELIMINATIONS
For the 2012 tax year and after, a subgroup elimination return can be converted to a nonlife elimination return.
This is beneficial to those who had eliminating entries entered on their subgroup eliminations for the federal
return. However, for single-tier mixed group state consolidation, since there are no mid-level subgroup
subconsolidations, the subgroup elimination returns cannot be used. Now, the subgroup elimination returns
can be converted using this feature into the nonlife elimination return, and all existing subgroup eliminating
entries are then transferred to nonlife elimination return.

Also, starting with 2012, both 1120 and 1120-PC subgroup elimination returns can be combined into one
nonlife elimination return. This is beneficial to those who had eliminating entries on both 1120 and 1120-PC
subgroup eliminations for the federal return. This feature combines all 1120 and 1120-PC eliminating entries
into one set of entries on the non-life elimination return.
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E-filing

BESTPRACTICEFORCONVERSIONS

Best practice for the conversion is to make a copy of the subgroup elimination return. If the parent is an 1120
company, then the 1120 subgroup elimination return should be copied. If the parent is an 1120-PC company,
then the 1120-PC subgroup elimination return should be copied.

After copying, the return can be converted to a nonlife eliminations by selecting the appropriate button, 1120-
Non-life Eliminations or 1120PC-Non-life Eliminations. These buttons are found onOrganizer >
General Information > Basic Return Information > Return/Entity Type Conversion tab.

E-FILING
APDF copy of the federal return can be obtained and attached to the mixed group state consolidation return.
There are two copy options: one is to copy the federal return directly from the mixed group state consolidation
itself. The other option is to copy the federal return from a different return. The latter option should be chosen
for a mixed group state combined return that uses the single-tier structure, since it is not federally compliant.
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PRINT
1. Select Print on the Organizer toolbar.

Figure 12:1

2. The Print Selection screen opens a new window. Within this screen you can:

l Verify the return type to print

l Select desired copy types

l Include e-file attachments

l Select the all returns, or portions of the return to print

l Enter a file name

l Create the print file

l Review previous print history for the return
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Print

3. Select the returns you wish to print.

Figure 12:2

4. Enter the File Name.

5. SelectCreate.

Create populates the History. This History area shows the file name, print status, print selection, start date
and time, and end date and time.

Once the print process has completed, you will see three options in the Actions column:

l ClickOpen to open the print file in PDF format within a separate browser window.

l ClickDownload to save the PDF to a desired location.

l ClickDelete to delete the print file.
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Print Options

Print Preview
Print Preview provides an on-screen view of a return and all associated forms, schedules, and supporting
documents.

Figure 12:3

PRINT OPTIONS
There are three places to go to review print options:

l Return and Print Options

l 1120-L Options

l 1120-PCOptions
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Print Options

Return and Print Options
Navigation:Organizer > General Information > Return and Print Options > Basic Options tab

Where to go for control whether to print:

l Number of copies, return number, date and other information at the bottom of each page

Figure 12:4
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Print Options

l Workpapers with the tax return and other documents

Figure 12:5
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Print Options

Some of the options that can be selected for printing are:

l Include or omit return-specific information at the bottom of each page

l Print workpapers with the return

l Print return as an 1120-L, even if the percent-of-reserves test is not met

l Include Loss Reserve Discounting and Salvage and Subrogation workpapers with the return

l Force print return even if out of balance

l M-3 print options

l Suppress print of M-1 and M-2

l Print LRDWorkpapers

l Print Annual Statement pages

If the return does not print as expected, always check the Return and Print Options screen. An option might
exist to change the appearance of the printed return.

Use Print Preview to check the appearance of the return before sending the return to the printer.
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Print Options

Compute/Print Options for Schedule M-1/M-3
To change compute/print options for the Schedule M-1 or M-3:

1. Select Organizer > General Information > Return and Print Options > Tax Form Options tab.

Figure 12:6

2. Select the Schedule M-3 Options link.

3. The Compute Options section gives you computation choices for Schedule M-1 and M-3. The default is
calculation of both Schedule M-1 and M-3.

Schedule M-1 will not print if M-3 is completed unless you select the option to force print
Schedule M-1 from the Print Options section.

4. Use the Print Options section to suppress Schedule M-3 or force print Schedule M-1 when M-3 is
completed.
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Print Options

Reviewing Print Options
Check the print options before printing a return. By default, the system does not print out-of-balance returns. If
your return is not printing, make sure the Allow printing of the tax return even if it is out-of-balance
option is selected. If your return is not printing the way you expect, check your print options that include:

l Printing an out-of-balance return

l Suppressing information at the bottom of each page

l Attachments

l Number of copies

l Non-Tax forms

l State suppression

Workpapers display supporting detail for the numbers appearing on a return. Be sure to provide an audit trail
from the Tax Form to the Organizer. Workpapers can be printed separately or with the tax return.
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CHAPTER 13: INTERNATIONAL INSURANCE
RETURNS

USING FOREIGN TAX CREDIT DATA ENTRY SCREENS IN
AN 1120L OR 1120PC BINDER TO POPULATE FORM 1118
An insurance binder (return type of 1120L or 1120PC) with an international filing type of Foreign Tax Credit can
be included in the international calculations (TIBS, FTC and Schedule A&H, and Transfer to US1118).

Currently, all binders with an international filing type of Foreign Entity must have a return type of 1120 to be
included in the international calculations (E&P, Look-Thru, Subpart F, and Transfer to US5471). The
international filing type (None, Foreign TaxCredit, or Foreign Entity) is assigned at the entity level and inherited
by the binders for that entity. Selecting Foreign TaxCredit or Foreign Entity for a binder is permanent.

Viewing the International Filing Type for an Entity
1. On theMy Binders screen, select the binder.

2. Select Properties and then theGeneral tab.

Creating the Top Consolidation Binder
The top consolidation binder should have an international filing type of Foreign Tax Credit and a return type of
1120 rather than 1120L or 1120PC. However, any mix of these binder return types is allowed on the Domestic
and International Members tabs of the top consolidation binder for international calculation purposes.

Reviewing the Members
1. Select a top consolidation binder.

2. Select Properties and then click theMembers tab.
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International Summary Chart of Accounts

Valid Entity Types in International Calculations
The following entity types are allowed for international calculations:

Parent Division (used in div conmembers)

Subsidiary Elimination

Div Con (used in top
consolidationmembers)

Corporate single entity

A subconsolidation entity is not valid for international calculations. If a subconsolidation entity is used on the
Domestic Members screen, the subsidiaries of the subconsolidation should be used on the International
Members screen for inclusion in the international calculations.

For the valid entity types, when the Foreign Tax Credit binder is added to the Domestic Members screen, the
binder is automatically inherited by the International Members screen for inclusion in the international
calculations.

INTERNATIONAL SUMMARY CHART OF ACCOUNTS
The International Summary Chart summarizes the earnings and profit to reduce the amount of data that
must be sourced in each entity. The accounts and descriptions listed in the chart define the rows on the
sourcing workpaper in the binder. Each user-defined account has a system-defined four-digit account type
assigned that is used for international calculations only. An example of this chart is shown below.

Figure 13:1

The Federal Chart of Accounts must be cross-referenced to the International Summary Chart in order for
amounts to flow to the sourcing workpaper. The International Cross Reference screen establishes the
relationship between the federal chart and the summary chart.
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International Summary Chart of Accounts

An example of the Federal to International cross-reference chart is shown below:

Figure 13:2

Assigning Federal and International Chart of Accounts
Federal and international charts of accounts can be assigned to binders with return types of 1120L and 1120PC
and an international filing type of Foreign Tax Credit. These charts are necessary for data entry or import to the
FTC sourcing workpaper. Charts are assigned at an individual binder level or to a group of entities through
Enterprise Control Panel.
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International Summary Chart of Accounts

You can view chart assignments by right-clicking the binder and selecting Properties:
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International Summary Chart of Accounts

Figure 13:3
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Data Entry and Import into Foreign Tax Credit Screens

DATA ENTRY AND IMPORT INTO FOREIGN TAX CREDIT
SCREENS
For 1120L and 1120PC binders, the following Foreign Tax Credit data entry screens are available for data
entry or import:

l Sourcing Workpaper

l Interest Apportionment Information

l R&D Apportionment Information

l Foreign Income Taxes

Since TAS functionality exists for 1120L and 1120PC binders, tax adjusted amounts flow directly to the FTC
Sourcing workpaper trial balance column. For international calculation purposes, the amounts in this column
can be overridden manually or by import. Batch and single entity imports have been created for import into the
Sourcing Workpaper Trial Balance Override screen. Sourcing workpaper trial balance amounts (from
either TAS transfer or override), along with any allocation or apportionment, are required for successful
international calculations.

The Sourcing Workpaper Trial Balance Override template is defined as follows:

Divisional Consolidations
Similar to a binder with a return type of 1120, international information for an insurance divisional consolidation
can be entered at the division or divisional consolidation level. Each division of the divisional consolidation
should have the same return type and international filing type as the divisional consolidation. Each division may
use a different federal chart of accounts but must use the same international chart of accounts. In this scenario,
at the enterprise level, multiple federal charts would be cross-referenced to the same international chart.

TAS preliminary balance and journal entry adjustment amounts are always entered at the divisional level. The
amounts then consolidate in the divisional consolidation process.

When sourcing is performed at the division level, sourcing workpaper and other international data is imported
or entered in the division binders on data entry screens located beneath the Foreign Tax Credit folder. This
international data then consolidates in the divisional consolidation process.

When sourcing is done at the divisional consolidation level, all data entry or imports on data entry screens
located beneath the Foreign Tax Credit folder (including the Sourcing Workpaper Trial Balance Override
import) is completed in the consolidated binder.
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Preparing Form 1118

To set the data entry level, right-click the Divisional Consolidation Binder Properties, click the
International tab, and then check (or uncheck) the box.

PREPARING FORM 1118
The Form 1118s populated by the international calculations are under the Intl Foreign Tax Credit and Intl
Foreign Tax Credit - AMT Organizer folders. Data manually entered or transferred to these international
versions of the 1118 will not consolidate at a higher level. These organizers should be used throughout the
organization structure if international calculations are used.

TAX CREDIT
When you execute the transfer to the 1118 from the International Compute screen, data is transferred to
international 1118s in the top consolidation and legal entity binders (that is, Parent, Subsidiary, and Div Con
binders with an international filing type of Foreign Tax Credit). The calculated amounts for the Form 1118 can
be transferred to the current Top Con binder, or a different Top Con binder. As part of the transfer process, any
information currently in the Form 1118 of the transfer destination binder is deleted. Therefore, we recommend
that you wait until the last transfer from the international computes is done before you manually enter or
override any information in the 1118 Organizer.
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Tax Credit

The International Compute dialog box is depicted below, with the Transfer To US1118 option selected for a
specific Top Con binder.

Figure 13:4

ONESOURCE
1120 INSURANCE GUIDE


	Chapter 1: Insurance Returns
	Topics Covered
	How do I get started?
	Charts for Insurance Returns
	Consolidations


	Chapter 2: Setting Up ONESOURCE Income Tax for Insurance Returns
	How to Set Up ONESOURCE Income Tax for Insurance Returns
	Chart and Adjustment Information
	ONESOURCE Income Tax Insurance Functionality

	NAIC Annual Statement Line Mapping Chart
	Tax Accounting System with Insurance
	NAIC Annual Statement Reconciliation
	NAIC Annual Statement Line Mapping Chart

	Tax Accounting System Menu Tree with Insurance
	NAIC Annual Statement Reconciliation Screen
	Action Items

	Working Trial Balance (WTB) and Insurance
	State Taxable Income Workpapers
	1120PC Schedule E and F Options


	Chapter 3: Selecting the Data Source
	NAIC Annual Statement
	Electronic Organizer

	Chapter 4: Creating Your Return in ONESOURCE Income Tax
	Step 1: Rollover Return
	Step 2: Choose Return/Entity Type
	Step 3: Enter Federal Tax ID Number
	Step 4: Select the Data Source
	Tax Accounting System Menu Tree for Insurance
	NAIC Annual Statement Reconciliation Screen
	Opening the NAIC Annual Statement Reconciliation
	Opening Insurance Workpapers
	Step 5: Set Up Division
	Step 6: Determine Net Operating Loss


	Chapter 5: 1120L Returns
	Life Insurance Reserves Test
	Failed Life
	1120L Unique Items
	Failed Life
	Using The Life NAIC Import

	Unique Items
	DAC – Deferred Acquisition Costs
	Schedule T


	Chapter 6: 1120-PC Returns
	1120-PC Unique Items
	Loss Reserve Discounting (LRD)
	Salvage and Subrogation
	Failed Life
	Deferred Acquisition Costs (DAC)

	Loss Reserve Discounting (LRD)
	LRD Lines
	Compute Options
	Print Suppression Options
	Discounting Summary

	Salvage and Subrogation
	Methods of Calculation of Salvage and Subrogation
	S&S Options


	Chapter 7: Working in the Tax Application
	Cross-Checking of Data Source Types
	Organizer and Tax Forms
	General Information
	Reviewing the Tax Return

	Chapter 8: State Returns
	Activating State Returns
	Allocation and Apportionment

	Chapter 9: Net Operating Loss
	Non-SRLY NOL
	SRLY NOL Entry
	S382 NOL
	NOL Organization and Rules
	NOL Offsetting Rules and Order
	NOL Organizer Override Rules

	Limitation of Nonlife NOL Against Life Subgroup Income
	LNL Eligibility Check Box
	Examples of NOL Utilization
	NL Examples
	LNL Examples

	Common NOL Support Questions

	Chapter 10: Consolidating the Return
	Preparing for Consolidation
	Elimination Return
	Types of Elimination Returns

	Subgroup Consolidation
	1120 Subgroup Subconsolidation
	1120-PC Subgroup Subconsolidation
	1120-L Subgroup Subconsolidation
	Subgroup Top Consolidation

	Nonlife Consolidation
	Nonlife Subgroup or Nonlife Top Consolidation

	Life Nonlife Consolidation
	Tools for Consolidation
	Subview
	Schedule K Questions

	Form 851: Corporate Affiliations Schedule
	Preparing Form 851
	Consolidation Carry Information
	Top Consolidation
	Entering Information for Form 851
	Printing Form 851


	Chapter 11: Mixed Group State Consolidation
	Multi-tier Mixed Group State Consolidation Structures
	Single-Tier or Flat Mixed Group State Consolidation Structure
	Nonlife Eliminations
	E-filing

	Chapter 12: Printing the Return
	Print
	Print Preview

	Print Options
	Return and Print Options
	Compute/Print Options for Schedule M-1/M-3
	Reviewing Print Options


	Chapter 13: International Insurance Returns
	Using Foreign Tax Credit data entry screens in an 1120L or 1120PC binder to p...
	Viewing the International Filing Type for an Entity
	Creating the Top Consolidation Binder
	Reviewing the Members
	Valid Entity Types in International Calculations

	International Summary Chart of Accounts
	Assigning Federal and International Chart of Accounts

	Data Entry and Import into Foreign Tax Credit Screens
	Divisional Consolidations

	Preparing Form 1118
	Tax Credit


